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Introduction

This document covers the integration with J.D. Edwards OneWorld. An Oracle Imaging and Process Management and J.D. Edwards WorldSoftware integration is also available.

Primary Functions

There are four primary functions in the OneWorld integration:

· Search for IBPM Documents,

· Update Process and Document Fields,

· Single Step Data Entry from Document and

· Single Step Data Entry from Batch.

Design Goals

Four key issues were considered during design of this integration:

· Seamless Integration

· Minimal impact to OneWorld environment

· Leverage existing IBPM functionality

· Minimal time necessary for implementation in a OneWorld environment.

Prerequisites

Before proceeding with the installation of the EIS, the following prerequisites must be met.

· The current version of Imaging must be installed and operational to use the Search functionality of the integration.  Please see the documentation that comes on the IBPM CD for complete installation instructions.

· Install MSVS C++ prior to installing JDE OneWorld.

· The current version of Process must be installed and operational to use the Update or Single Step Data Entry from Document functionality of the integration.  Please see the documentation that comes on the IBPM CD for complete installation instructions.

· Captovation’s eCapture 4.1 must be installed and operational to use the Single Step Data Entry from Batch functionality of the integration.  This document will outline the installation instructions and additional documentation is available on the eCapture CD.

· J.D. Edwards OneWorld must be installed and operational to use any portion of this integration.  If a complete OneWorld system is not available, J.D. Edwards has a standalone demonstration CD called Demo Jr., which contains a fully functional OneWorld system and database.  This document includes the installation steps for OneWorld Demo Jr.

· The following versions are supported:  JDE B7.3.3.x, Xe, ERP8, ERP8, JDE 8.9 and 8.10.

Document Content

This document allows installation of the EIS into a production environment.  This document also contains instructions for setting up a demonstration system.  There are three (3) different install scenarios covered in this document.

· Install on customer’s live or CRP (Conference Room Pilot) OneWorld system,

· Install on OneWorld Demo Jr. B7.3.3.x version, and

· Install on OneWorld Demo Jr. Xe version.

Installing J.D. Edwards OneWorld

The section provides instructions for the installation of the OneWorld Demo Jr. CD.  If a OneWorld system is already in place, skip to the next section (Installing eCapture) after making sure the development machine to be used meets the requirements in Appendix A.

Normally, the OneWorld Demo Jr. CD is available to J.D. Edwards’ customers and J.D. Edwards’ partners.  Stellent is a customer and partner.  Stellent has made special arrangements with J.D. Edwards to allow our certified Solution Providers to also use the Demo Jr. CD as long as all technical support calls are placed to Stellent rather than J.D. Edwards.  If your organization does not fall into one of these categories and there is a need to demonstrate the integration with J.D. Edwards OneWorld, please contact Stellent’s Product Management department to make alternate arrangements.

The OneWorld Demo Jr. CD is installed on a client machine.  This computer is referred to as the Development Machine.  Please make sure the development machine to be used meets the requirements in Appendix A.  Microsoft Windows 95/98 is not a recommended platform for Xe development.

Install OneWorld Stand Alone System

1. Place the J.D. Edwards OneWorld Demo Jr. CD in the CD-ROM drive.  The J.D. Edwards OneWorld installation program launches automatically if AutoLaunch is enabled.  If the installation program does not launch automatically, run Setup.exe from the root of the J.D. Edwards OneWorld CD.  There is a troubleshooting note for this step if the operating system is Windows 95 or Windows 98.

2. The J.D. Edwards OneWorld Installation Manager is displayed.

3. Depending on which version of Demo Jr., select the B7331 or B7332 or Xe Standalone Install.  The Starting setup dialog displays briefly and then the Client Workstation dialog appears.  The welcome window requests all programs be closed during the installation to prevent sharing violations while updating files.

4. Click Next to accept the License Agreement.  Two installation choices are displayed in the Package setup dialog.

5. Select DEMOHELPS to install J.D. Edwards OneWorld with the associated help files.

6. Click Next.  The installation calculates the package size. The Setup Type dialog is displayed.

7. Make sure Development is selected for the type of installation.

8. If the desired installation drive is not in the Install Path field click the ellipses (…) to the right of the field to choose another path.  The Drive selection field at the bottom of the screen provides information on the available space on each drive and the required space for the installation.  The Verifying Disk Space dialog displays after a drive is selected.

9. Click Finish.  The Client Workstation Setup Progress bar will display the status of the installation throughout the process.  When complete, the Client Workstation Setup dialog appears with the message Client Workstation Setup Succeeded.

10. Click OK.  The J.D. Edwards OneWorld Installation Manager appears.

11. Close it using the X in the upper right hand corner of the dialog.

Notes for Windows 95 / 98 Installations

12. Microsoft Windows 95/98 is not a recommended platform for Xe development.

13. When installing on Windows 95 or Windows 98, the OneWorld Demo Jr. install may not properly set the data sources in the JDE.INI.  Please verify that the following lines are set properly in your JDE.INI.

[DB SYSTEM SETTINGS]

Version=43

Default User=DEMO

Default Env=DEMOB73

Default PathCode=DEMO

Base Datasource=OneWorld Local

Object Owner=

Server=

Database=OneWorld Local

Load Library=JDBODBC.DLL

Decimal Shift =N

Julian Dates=N

Use Owner=N

Secured=N

Type=A

Library List=

Default Pwd=_

14. Verify that the path on a Windows 95 / 98 system includes D:\B7\system\bin32 and D:\B7\DEMO\bin32 where D: is the drive where Demo Jr. was installed.

Authorize the J.D. Edwards OneWorld Demo Software

To gain access to the OneWorld Demo, the user must receive an authorization code in one of two ways. Calling J.D. Edwards and requesting the code with a Business Partner ID or running the Authorization generating software on the target system.  If a call to J.D. Edwards becomes necessary the phone number is provided on the security setup screen when opening OneWorld for the first time.  The following steps describe how to acquire and run the Authorization code generator.

Note – The following steps will need to be done every 90 days because the Software Protection Code will automatically expire.

Installing the Software Protection Code Generator Utility

1. Contact Technical Support to obtain SetupOneWorldXE.zip or SetupB733.zip.

2. Run the executable inside of the zip file.

3. Click Next. The Information window opens.  The following message is displayed.  This tool will enable the user to obtain a Software Protection Code for any B73.3.x Standalone Install when the license expires.  When your license expires, you must re-run this program from the Internet so that the Software Protection Code access can be updated.

4. Click Next.  The files are installed. The Standalone Update is displayed with the following message. Your installed version of Standalone can now obtain SPC codes automatically. 

5. Click OK.  The setup window closes.

OneWorld Security Setup

1. Open J.D. Edwards OneWorld from either the desktop shortcut or the Start Programs menu.  The OneWorld Sign on dialog is displayed.

2. Enter a User ID of DEMO.

3. Tab to the Password field. The database used in Demo Jr. is a Microsoft Access database and therefore, once the system has been initialized any characters in this field will allow access to the database. Enter any alphanumeric characters for the password.

4. Tab to the Environment field.  The search (Flashlight) icon is displayed to the left of the field. Click the flashlight to view a list of available environments. 

5. The Select User Environment dialog is displayed. Select the DEMOB73 Environment by clicking on the row and clicking Select in the toolbar or by double clicking DEMOB73.

6. Click OK.  The Just in Time Install status bar shows a number of files being transferred.  

7. Once the transfer is complete the J.D. Edwards Security dialog is displayed.  Click OK to set up security.  The J.D. Edwards Security Setup dialog is displayed.  An Authorization Code must be received to initialize J.D. Edwards OneWorld.  If the OneWorld Access Code Generator has been installed, then you can press the Get Access Code button to automatically populate appropriate access code.  If the Access Code Generator utility has not been installed, call the number for J.D. Edwards provided on the dialog.

8. Click OK.  The progress bar indicates the movement of files.  J.D. Edwards OneWorld Explorer and an accompanying tip of the day dialog open.

9. Close the Tip of the day dialog.

10. The J.D. Edwards OneWorld demo has been installed and authorized.

11. Close OneWorld.

Installing eCapture

Captovation’s eCapture software is an integral part of the integration with J.D. Edwards OneWorld.  The integration works with eCapture to deliver the feature called Single Step Data Entry from Batch.

1. Place the eCapture 4.1 CD in the CD-ROM drive.  If auto run is enabled, Install.htm is automatically displayed in the default Browser program.  If auto run is not enabled, then open Install.htm by double clicking on it with Windows Explorer.  It is located on the root of the eCapture CD.

The eCapture Installation and Configuration screen is displayed.  It gives the option to install the Server Components, Workbench, User Guide, Administrator Guide, or Sales Brochure.

2. Select the link for eCapture Workbench.   The eCapture WorkBench Installation and Configuration screen is displayed, which says to press the link to begin the setup of eCapture.  It also reminds that if you are installing on Windows NT, that you need to have Administrator privileges.

3. Press the link to run \Setup\Setup.exe.  A File Download screen is displayed.

4. Choose the Run this program from its current location option.

5. Click OK.  Depending on how the workstation is configured, a Security Warning screen that advises that the object to be verified is unknown to the Trust Provider.

6. Click Yes to continue.  The InstallShield Wizard starts and the Welcome screen is displayed.  It advises to close all other applications before continuing.

7. Click Next.  The User Information screen is displayed.  Confirm or change the User and Company Name.

8. Click Next.  The Choose Destination Location window is displayed.  Confirm or change the destination Folder.  Stellent recommends leaving the destination folder set for C:\Program Files\eCapture.

9. Click Next.  The Select Components screen is displayed.  Make sure that the following components are selected: eCapture WorkBench, ecIndex, ecScan, ecAdmin, and eCapture EDP.  Stellent recommends leaving these default settings.

10. Verify enough space is available on the destination drive.

11. Click Next.  The Select Program Folder screen is displayed.

12. Confirm or change the Program Folder name.  Stellent recommends leaving the Program Folder Name set to eCapture.

13. Click Next.  If DCOM is not installed, the eCapture installation may install DCOM.  At the end of the DCOM installation, when it prompts to restart your machine, say No and the eCapture installation continues.

14. If MDAC is not installed, the eCapture installation may install MDAC.  At the end of the MDAC installation, when it prompts to restart your machine, say No and the eCapture installation continues.

15. The eCapture Workbench files are installed.  The Setup Complete dialog is displayed.

16. Select the No, I will reboot my computer later radio button.

17. Click Finish.  The eCapture installation wizard closes.

18. The Browser with the eCapture WorkBench Installation and Configuration instructions is displayed.

19. Close the Browser.

20. Reboot the machine.

Installing EIS

Please refer to “Installation and Upgrade” section of the on line EIS.CHM help file for installation instructions, when prompted for Features, please select “Application Link” and “Application Link for EnterpriseOne Windows Client”. EnterpriseOne was formerly known as PeopleSoft EnterpriseOne.
Configuring J.D. Edwards OneWorld (B7.3.3.x)

There are two primary steps to configuring OneWorld – Adding and configuring the new objects and adding and configuring the functions on the forms.  The steps for adding the objects remain the same regardless of what solution is being installed, but the steps relating to the buttons and forms may change depending on the customers’ requirements.  

As of the Acorde Integration Tools 4.0 release, all the objects and data structures may be imported using a product called Boomerang by Pastuhov Computing.  The Boomerang Lite program is a free download from the following site:

http://members.optushome.com.au/apastuhov/downloads.htm
The Boomerang package file containing all objects is called:

Windows Integration-8.BG1

For details regarding using the Boomerang software, please refer to the EnterpriseOne Web Integration section of EIS.chm. 

After importing the Boomerang package, please skip to the section “Building OneWorld Business Function Objects”

1. To manually create all the objects and data structures, please follow the instructions precisely to use the demonstration script.  If configuring a production system, consult with your customer and their J.D. Edwards integrator before configuring OneWorld.Open J.D. Edwards OneWorld from either the desktop shortcut or the Start Programs menu.  The OneWorld Sign on dialog is displayed.

2. Enter a User ID of DEMO.

3. Tab to the Password field. The database used in Demo Jr. is a Microsoft Access database and therefore, once the system has been initialized any characters in this field allow access to the database. 

4. Enter any alpha-numeric characters for the password.

5. The Environment field should be set to DEMOB73.

6. Click OK.

7. Throughout this process, the Just in Time Install window may appear as additional software is installed.  When complete, the OneWorld Explorer main menu is displayed.

Adding and Designing OneWorld Objects (B7.3.3.x)

Stellent has prepared data structures and business functions for the Accounts Payable and Accounts Receivable modules.  There is also a Generic data structure and business function that can be used in any OneWorld module.

This is a list of all of the objects that could be added to the system if installing all three business functions.   It is not necessary to apply all of these objects if using one business function.

The names of the objects closely match the OneWorld naming convention, but these object names can be modified.  If the data structure object name is modified, then the new name will need to be updated into the .C and .H files, which contain the actual business function.  If the name of the business function object is changed then the name of the .C and .H files would also need to be changed.  Consult with Stellent or a J.D. Edwards integrator to change these object names or use a different data structure.

· OPTKBL
IBPM Business Function Library
BL
Business Function Library

· BOPTKAP
IBPM Business Function – AP Short 
BSFN
Business Function

· DOPTKAP
IBPM Data Structure  - AP Short
DSTR
Data Structure

· BOPTKAR
IBPM Business Function - AR Short
BSFN
Business Function

· DOPTKAR
IBPM Data Structure – AR Short
DSTR
Data Structure

· BOPTKGN
IBPM Business Function – GN Short
BSFN
Business Function

· DOPTKGN
IBPM Data Structure – GN Short
DSTR
Data Structure

Add the Business Function Library (BL) Object (B7.3.3.x)

A Business Function Library is a shell in which Business Function (BSFN) objects are stored and compiled.   When compiled, the BL (Business Library) object becomes even more important. All the BSFN objects are compiled into one .dll file, which is located in the B7\[PATHCODE]\BIN32 directory.

The steps to add objects to OneWorld are very straightforward.  Begin the process by opening the Object Librarian.

1. Type OL in the Fast Path field in OneWorld Explorer.  The Object Librarian dialog opens.

2. Enter BL in the Object Type field in the Work With Object Librarian dialog.

3. Click the Add button.  The Object Librarian - Add Object dialog opens.  An error is received if the Add button is pressed and an object type has not been specified in the Object Type field.

4. Enter OPTKBL in the Object Name field.

5. Enter a description of IBPM Business Function Library.

6. Enter a Product Code of 58.

7. Enter a Product System Code of 58.

8. Enter 1 in the Object Use field.

9. Enter a SAR Number of IBPM (Use all upper case letters).

10. Click OK in the toolbar.  The Object Librarian - Business Function Parent Library opens.  The descriptions entered in the Add Object dialog appears in the available fields.

11. Click OK. The Business Function Parent Library closes. The following table describes the fields in the Object Librarian for the BL Library.  The Object Librarian – Work with Object Librarian window appears.

Add the Business Function (BSFN) Objects (B7.3.3.x)

A business function is an encapsulated reusable routine that can be called through event rules.  Stellent has already created the routine (C program) that needs to be attached to this business function to keep the implementation straightforward.

1. Enter BSFN in the Object Type field in the - Work With Object Librarian dialog.

2. Click the Add button.  The Object Librarian - Add Object dialog opens.  An error is received if the Add button is pressed and an object type has not been specified.

3. Enter BOPTKAP in the Object Name field.

4. Enter IBPM Business Function - AP Short into the description field.

5. Enter a Product Code of 58.

6. Enter a Product System Code of 58.

7. Enter 1 in the Object Use field.

8. Enter the Function Location of 2.

9. Enter a Source Language of C.

10. Enter a SAR Number of IBPM (Use all upper case letters).

11. Click OK in the toolbar.  The Object Librarian - Business Function Parent Library opens.  The descriptions entered in the Add Object dialog appears in the available fields.

12. Click OK. The Business Function Source Librarian closes. The Object Librarian is ready for the next object to be added.

13. Repeat steps 1 – 12 of this section for the other two business functions objects.  Only the Object Name and the Descriptions change. All other information should be entered as defined above.

	Object
	Description.

	BOPTKAR
	IBPM Business Function - AR Short

	BOPTKGN
	IBPM Business Function – Generic Short


Add the Data Structure (DSTR) Objects (B7.3.3.x)

Business Function Data Structures are required and linked to the business functions described above.  Stellent has defined three data structures.  The number of fields in the data structures has been optimized to balance the normally required fields with the amount of time necessary to implement the data structure.  Stellent also built in some generic fields for flexibility.  If for some reason these data structures do not work in a particular implementation, please contact Stellent.

1. Enter DSTR in the Object Type field in the -Work With Object Librarian dialog.

2. Click the Add button.  The Object Librarian - Add Object dialog opens.  An error is received if the Add button is pressed and an object type has not been specified.

3. Enter DOPTKAP in the object name field.

4. Enter a description of IBPM Data Structure - AP Short.

5. Enter a Product Code of 58.

6. Enter a Product System Code of 58.

7. Enter 360 in the Object Use field.

8. Enter a Structure Type of 1.

9. Enter a SAR Number of IBPM (Use all upper case letters).

10. Click OK in the toolbar.  The Object Librarian - Parameter Design opens.  The descriptions entered in the Add Object dialog appears in the available fields.

11. Click OK. The Parameter Design Dialog closes.  The Work with Object Librarian is ready for the next object to be added.

12. Repeat steps 1 – 11 of this section for the other two data structure objects.  Only the Object Name and the Descriptions change. All other information should be entered as defined above.

	Object
	Description

	DOPTKAR
	IBPM Data Structure – AR Short

	DOPTKGN
	IBPM Data Structure - Generic Short


Design the Business Function (BSFN) Objects (B7.3.3.x)

The objects have been created now they need to be designed.  This section describes the process of designing the business functions.  This process begins in the Work With Object Librarian dialog.

1. Enter BOPTK* in the yellow field above Name.  Select Find to display all previously added Business Functions.

2. Double click on the BOPTKAP record.  The Business Function Source Librarian dialog opens.

3. Highlight the first row of the grid and select Design from the toolbar.

4. The Parent DLL field must be OPTKBL.

5. Leave the Business Function Location at 2.

6. Enter PassAPShortToIBPM in the Function Name field in the table.  Press Tab.

7. Enter Pass AP Short Structure to IBPM in the description field.  Press Tab.

8. Enter APP in the Function Category field.  This can either be entered directly or searched for using the Search function provided in the field.  Press Tab.

9. Don’t put anything in the Function Use field.  Press Tab.

10. Enter the numeral 3 in the F3 Code field.  Press Tab.  You are now on the Template Name field.

11. Highlight the row by selecting the gray box on the left of the row.

12. Go into the Preferences menu option and verify that the Exit Row option is checked.

13. Select Parameters from the Row Exit menu or the Parameters button in the Row Exit.  The Select Business Function Parameters dialog opens.

14. Search for the data structure by putting DOPTKAP in the Source Module column and press Enter.

15. Double click on the DOPTKAP record when it is returned to make your parameter selection complete.  The Object Librarian – Business Function Design screen is displayed and the Template Name field will be populated with DOPTKAP.

16. Click OK to return to the Object Librarian – Business Function Source Library screen.

17. Click OK to return to the Object Librarian – Work with Object Librarian screen.

18. Repeat steps 1- 19 of this section for the other two business functions.   Only the function name, description, and data structure change.

	Function Name
	Description
	Data Structure

	PassARShortToIBPM
	Pass AR Short Structure to IBPM
	DOPTKAR

	PassGNShortToIBPM
	Pass GN Short Structure to IBPM
	DOPTKGN


Design the Data Structure (DSTR) Objects (B7.3.3.x)

The data structure objects have been created, now they need to be designed.  This section describes the process of designing the business functions.  This process begins in the Work With Object Librarian dialog.

1. Enter DOPTK* in the yellow field above Name.  All previously added Data Structures are displayed.

2. Double click on the DOPTKAP record.  The Parameter Design screen opens.

3. Highlight the first row of the grid and select Design from the toolbar.  The Data Structure Business Function design dialog opens.  This window allows the data structure to be built by selecting items on the right in the Dictionary Items field and dragging them to the Structure Member Field on the left.

4.  In the Dictionary Items section, scroll to the right until the Alias field is exposed.

5. Enter the first Alias (USER) in the Yellow field above Alias and press enter. The Dictionary Item with the Alias of User is returned.

6. Drag the User Dictionary Item to the left hand window, Structures Members, and then drop it near the top of the window under the column headings. The Dictionary Item with Alias of User now occupies the first row in the Structure Members table and is its Structure Member name of szUserId is displayed.

7. Double click on the field in the column Structure Member (szUserId) and replace that name with the Stellent field name of Username.

8. Repeat the process for all the Aliases in the following table by dragging them below the existing Structure Members.  Once the Structure Member table becomes full, drop the remaining structure members in the horizontal scroll bar as seen in the picture below.  The data structure must be entered in the exact order documented here.
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Build your data structure by searching for items in the search grids o the right, then selectthem and drag and drop them onto





	Structure Member
	Data Item


	Dictionary Items 

Alias
	Dictionary Items

Data Type
	Dictionary Items

Field Size

	Username
	UserId
	USER
	String 
	10

	ScreenName
	DescriptionAlpha
	DSCA
	String 
	40

	MapName
	DescriptionAlpha
	DSCA
	String 
	40

	ActionCode
	ActiontobePerformed
	ACN
	Char 
	1

	Module
	DescriptionAlpha
	DSCA
	String 
	40

	SupplierNumber
	Address Number
	AN8
	Number
	8

	Company
	Company
	CO
	String 
	5

	InvoiceDocType
	DocumentType
	DCT
	String 
	2

	InvoiceNumber
	VendorInvoiceNumber
	VINV
	String 
	25

	InvoiceAmount
	AmountGross
	AG
	Number
	15

	InvoiceDate
	DateInvoiceJ
	DIVJ
	Date
	6

	BusinessUnit
	BusinessUnit
	94U
	String 
	12

	PurchaseOrder
	PurchaseOrder
	PO
	String 
	8

	DocumentNumber
	DocVoucherInvoiceE
	DOC
	Number
	8

	CheckNumber
	CkControlNoAPCh
	CKC
	Number
	8

	CheckDate
	DateCheck
	CKD
	Date
	6

	CheckAmount
	AmountCheckAmount
	CKAM
	Number
	15

	GenericNumeric1
	GenericNumeric1
	GNUM1
	Number
	15

	GenericNumeric2
	GenericNumeric2
	GNUM2
	Number
	15

	GenericNumeric3
	GenericNumeric3
	GNUM3
	Number
	15

	GenericDate1
	JulianDate
	JDATE
	Date
	6

	GenericDate2
	JulianDate
	JDATE
	Date
	6

	GenericDate3
	JulianDate
	JDATE
	Date
	6

	GenericString1
	GenericText
	TXT0
	String 
	80

	GenericString2
	GenericText
	TXT0
	String 
	80

	GenericString3
	GenericText
	TXT0
	String 
	80


9. Click OK after all the fields have been entered in the sequence it appears in the table. The Define Data Structure dialog closes.  The Parameter Design dialog is now displayed.

10. Click OK.  The Parameter Design dialog closes.  The Object Librarian – Work With Object Librarian screen is displayed.

11. Repeat steps 1-11 for the other two data structure objects.  Use the tables below.

The following table is for the DOPTKAR (IBPM Data Structure - AR Short) only.

	DOPTKAR
	OneWorld
	OneWorld
	OneWorld
	OneWorld

	Structure Member
	Data Item
	Alias
	Data Type
	Field Size

	Username
	UserId
	USER
	String 
	10

	ScreenName
	DescriptionAlpha
	DSCA
	String 
	40

	MapName
	DescriptionAlpha
	DSCA
	String 
	40

	ActionCode
	ActiontobePerformed
	ACN
	Char 
	1

	Module
	DescriptionAlpha
	DSCA
	String 
	40

	Company
	Company
	CO
	String 
	5

	CustomerNumber
	Address Number
	AN8
	Number
	8

	DocumentType
	DocumentType
	DCT
	String 
	2

	GrossAmount
	AmountGross
	AG
	Number
	15

	InvoiceDate
	DateInvoiceJ
	DIVJ
	Date
	6

	BusinessUnit
	BusinessUnit
	94U
	String 
	12

	PONumber
	PurchaseOrder
	PO
	String 
	8

	GenericNumeric1
	GenericNumeric1
	GNUM1
	Number
	15

	GenericNumeric2
	GenericNumeric2
	GNUM2
	Number
	15

	GenericNumeric3
	GenericNumeric3
	GNUM3
	Number
	15

	GenericDate1
	JulianDate
	JDATE
	Date
	6

	GenericDate2
	JulianDate
	JDATE
	Date
	6

	GenericDate3
	JulianDate
	JDATE
	Date
	6

	GenericString1
	GenericText
	TXT0
	String 
	80

	GenericString2
	GenericText
	TXT0
	String 
	80

	GenericString3
	GenericText
	TXT0
	String 
	80


The following table is for the DOPTKGN (IBPM Data Structure - Generic Short) only.

	DOPTKGN
	OneWorld
	OneWorld
	OneWorld
	OneWorld

	Structure Member
	Data Item
	Alias
	Data Type
	Field Size

	Username
	UserId
	USER
	String 
	10

	ScreenName
	DescriptionAlpha
	DSCA
	String 
	40

	MapName
	DescriptionAlpha
	DSCA
	String 
	40

	ActionCode
	ActiontobePerformed
	ACN
	Char 
	1

	Module
	DescriptionAlpha
	DSCA
	String 
	40

	AddressNumber
	Address Number
	AN8
	Number
	8

	GenericNumeric1
	GenericNumeric1
	GNUM1
	Number
	15

	GenericNumeric2
	GenericNumeric2
	GNUM2
	Number
	15

	GenericNumeric3
	GenericNumeric3
	GNUM3
	Number
	15

	GenericDate1
	JulianDate
	JDATE
	Date
	6

	GenericDate2
	JulianDate
	JDATE
	Date
	6

	GenericDate3
	JulianDate
	JDATE
	Date
	6

	GenericString1
	GenericText
	TXT0
	String 
	80

	GenericString2
	GenericText
	TXT0
	String 
	80

	GenericString3
	GenericText
	TXT0
	String 
	80


Building OneWorld Business Function Objects (B7.3.3.x)

The Business Function Objects have been defined.  Now we need to compile the actual source code and data structure elements into the J.D. Edwards OneWorld environment.  The following steps may be different for a production OneWorld system.

Copy Source Files (B7.3.3.x)

If objects and data structures are imported from the Boomerang package, all source files are placed in the correct folders. Please continue to the next step.

For the OneWorld demo Jr. system, there are six source files that must be copied by the developer from the OneWorldBusinessFunctions directory on the EIS CD to the install directory for the J.D. Edwards OneWorld Directories.

1. Copy the *.C files (BOPTKAP.C, BOPTKAR.C and BOPTKGN.C) to the \\B7\Demo\Source directory from the OneWorldBusinessFunctions directory on the CD.

2. Copy the *.H files (BOPTKAP.H, BOPTKAR.H, BOPTKGN.H) to the \\B7\Demo\Include directory from the OneWorldBusinessFunctions directory on the CD.

Rebuild Libraries (B7.3.3.x)

Once the files are in place, then a library build must be performed.  The OneWorld program called BusBuild.EXE is used to perform this task and it is located in \\B7\System\Bin32.

1. Make sure the OneWorld application is closed.

2. Activate the BusBuild.EXE using Run from the Start menu or browsing and double clicking in Windows Explorer.

3. The BusBuild program will prompt you to log in the first time it is run.  Use the same login and password that was used to login into OneWorld.

4. Click on the Build drop down menu.

5. Click Rebuild Libraries in the Build drop down menu.  The Build Output dialog displays, reporting the progress of the build. The compile process time can take several minutes.  The compile Process is complete when the cursor is blinking at the bottom of the build field.

6. Scroll through the Build Output and find the following entries.

Generating Makefile: D:\B7\DEMO\obj\OPTKBL.mak

Makefile generated.

************OPTKBL************

jdertdll.c

Creating library D:\B7\DEMO\lib32\OPTKBL.lib and object D:\B7\DEMO\lib32\OPTKBL.exp

Rebased at 0x620E0000 : D:\B7\DEMO\bin32\OPTKBL.dll

Image processed by BindImage. 

OPTKBL.dll   -   0 error(s),    0 warning(s):  Built successfully. 
7. Make sure the OPTKBL.DLL is listed as having compiled successfully – 0 errors before continuing.

8. Close BusBuild by clicking on the X in the upper right hand corner of the dialog or clicking Exit from the File menu.

Build the Business Functions (B7.3.3.x)

The last step in preparing the business functions for use is the Build that happens inside of OneWorld.

1. Log into J.D. Edwards OneWorld and open the Object Librarian (type OL in the fast path and press Enter).

2. Leave the asterisk (*) in the object type field.

3. Type BOPTK* in the name column header and press Enter.

4. The list of objects Stellent Business Function objects created during the development process is displayed.

5. Select the IBPM Business Function – AP Short by double clicking the row or highlighting by clicking once and then clicking the Select button in the toolbar.  This will display the Business Function Source Librarian screen.

6. Make sure the row with the Computer Name is selected and then click Build in the tool bar.  The BusBuild.EXE launches and compiles the object.  OPTKBL.dll – 0 errors, 0 – warnings, Build Successful is announced when the compile is complete.

7. Close BusBuild by clicking on the X in the upper right hand corner of the dialog or clicking Exit from the File menu.  The Business Function Source Librarian is active.

8. Click OK.   The Business Function Source Librarian closes.

9. Repeat Steps 5 – 8 for the objects BOPTKAR (IBPM Business Function – AR Short) and BOPTKGN (IBPM Business Function – Generic Short).

Adding the Enabling Buttons to the OneWorld Forms (B7.3.3.x)

The first step in this process is to identify which OneWorld Job runs the form to be modified.  Next to the description in the OneWorld Explorer interface, find the Job to Execute column.  The Standard Voucher Entry program, which is part of the Accounts Payable solution that Stellent has created, has a Job to Execute of P0411.

1. From the Object Librarian, type P0411 in the Name column.  Make sure that the Ins Sys column header and the object type box are clear.

2. Click Find. The P0411 AP Standard Voucher Entry Application is displayed in the first row.

3. Double click on the P0411 AP Standard Voucher Entry Application. The Application Design Aid dialog displays. 

4. Go to the second line in the grid and under the Location field type your computer name. (Cut and paste this from the properties of Network Neighborhood on your desktop to avoid typographic errors.)

5. Type DEMO in the Path field.

6. Press Enter to proceed to the Status Code field.

7. Type 3 in the Path Code field.

8. Press Enter.  The SAR field is now enabled.

9. Type IBPM in the SAR field.

10. Press Enter.   The User field is now enabled.

11. Type DEMO in the User field.

12. Click OK to save the newly created record.  The Object Librarian screen is displayed.

13. Double click on the highlighted row with P0411 to return to the Application Design Aid.

14. Highlight the record in the grid, which corresponds to your machine name by selecting the gray box to the left of the row and then click the Design button on the toolbar.  The Form Designer loads.

15. Turn off the Did You Know window by clicking the Close button at the bottom of that dialog.

Add Search Buttons to the OneWorld Forms (B7.3.3.x)

1. One of the forms in the P0411 program is Supplier Ledger Inquiry. Using the Windows Menu option, make it the active window.

2. Select Form from the main dialog menu bar and choose Menu/Toolbar Exits. The Menu/Toolbar Exits dialog opens.

3. Highlight &Row and click Add.  The Exit Properties Dialog opens.  In the Exit Properties window, enter Search Invoice in the Short Text field.

4. In the Long field enter Search for Invoice.

5. Select Toolbar in the Type frame.  The State should be Enabled and Style should be Command.

6. Click OK to close the Exit Properties dialog box.

7. Repeat steps 16 through 19 using the following table to provide the guidelines for each menu addition.  Click OK after the information has been entered for each of the menu items.

	Short Text
	Long Text
	Type

	Search Supplier
	Search by Supplier Number
	Toolbar

	Search IBPM
	Search IBPM
	Toolbar


The Menu/Toolbar Exits window should look like the following.
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Configure the Search Buttons (B7.3.3.x)

1. Highlight the Search for Invoice row in the Menu/Toolbar Exits window and select the Event Rules button.  The Event Rules design dialog opens.

2. Select F(B) button in the Toolbar.  The Business Function Search dialog opens.

3. Enter Pass* for the Function Name and click Find.  The three Business Functions configured previously are displayed.

4. Double click on the highlighted record (PassAPShortToIBPM) in the Function Name Column or highlight by clicking on the gray box to the right of the row and clicking Select. The Business Functions dialog displays.

5. Three columns are viewable, Available objects, Value and Data Item.  Available objects are the objects, which can be assigned to the Data Items. Values show the Available objects that have been assigned.

6. To move an object from the Available objects column to the Value column click the Value cell where the Available Object is to be assigned.

7. Select the Available object by double clicking the item or select the desired item and use the arrows between the columns to move the Available object.  Use the following table to assign Available Objects to the Value for the appropriate Data Item.

Search by Invoice Data Mappings (B7.3.3.x)

	Available Objects
	Data Item

	SLUserId
	Username

	Literal – W0411G
	ScreenName

	Literal – Invoice by Inv Num and Supp ID
	MapName

	Literal – 1
	ActionCode

	Literal – 04
	Module

	GC SupplierNumber
	SupplierNumber

	GC Co
	Company

	GC DocType
	InvoiceDocType

	GC InvoiceNumber
	InvoiceNumber

	GC Gross Amount
	InvoiceAmount

	GC InvoiceDate
	InvoiceDate

	GC BusinessUnit
	BusinessUnit

	GC PurchaseOrder
	PurchaseOrder

	GC DocumentNumber
	DocumentNumber


When this table is complete, several Data Items will not have assigned values like Check Number, Check Date, etc., these fields are not used on this particular screen.

The fields labeled Generic provided at the bottom of the Data Items column have been created to provide an area to pass data specific to a customer’s implementation.  All fields not specifically referred to in this explanation can maintain a Value of NOT Assigned.

8. After all the Values are assigned, the direction of the flow of information needs to be assigned.  In the Dir column, between the Value and Data Item columns, the current (() symbol represents No flow of information.  To complete the Value assignments the flow of information must be from the Value to the Data Item. Accomplish this by clicking on the box in each mapped row until an arrow appears pointing to the right (().  Rows that have <NOT Assigned> do not need to have the direction arrow adjusted.

9. Click OK.  The Business Functions Dialog closes.  The Event Rules Design dialog is active.

10. In the Options Menu make sure Repeat for Grid is checked.

11. Click the Save and Exit button, which is the green check mark icon on the toolbar.  The Event Rules Design dialog closes.  The Menu/Toolbar Exits dialog is active.

12. Repeat the steps on Configuring Search Buttons for the Search by Supplier and Search IBPM menu items.  Use the following tables to establish the data mappings.  Basically all the fields are the same for all of the Search buttons except the MapName literal.  Don’t forget to set the Repeat for Grid option.

Search by Supplier Data Mappings (B7.3.3.x)

	Available Objects
	Data Item

	SLUserId
	Username

	Literal – W0411G
	ScreenName

	Literal – All Docs by Supplier ID
	MapName

	Literal – 1
	ActionCode

	Literal – 04
	Module

	GC SupplierNumber
	SupplierNumber

	GC Co
	Company

	GC DocType
	InvoiceDocType

	GC InvoiceNumber
	InvoiceNumber

	GC Gross Amount
	InvoiceAmount

	GC InvoiceDate
	InvoiceDate

	GC BusinessUnit
	BusinessUnit

	GC PurchaseOrder
	PurchaseOrder

	GC DocumentNumber
	DocumentNumber


Search IBPM Data Mappings (B7.3.3.x)

	Available Objects
	Data Item

	SLUserId
	Username

	Literal – W0411G
	ScreenName

	Literal – Blank
	MapName

	Literal – 1
	ActionCode

	Literal – 04
	Module

	GC SupplierNumber
	SupplierNumber

	GC Co
	Company

	GC DocType
	InvoiceDocType

	GC InvoiceNumber
	InvoiceNumber

	GC Gross Amount
	InvoiceAmount

	GC InvoiceDate
	InvoiceDate

	GC BusinessUnit
	BusinessUnit

	GC PurchaseOrder
	PurchaseOrder

	GC DocumentNumber
	DocumentNumber


13. When these steps are all done, click Close in the Menu/Toolbar Exits window.

14. Before moving on to the next screen, adjust the columns in the Supplier Ledger Inquiry.

Adjust the Columns in the Supplier Ledger Inquiry Grid (B7.3.3.x)

1. While in the J.D. Edwards Form Design Aid for P0411, make sure that the Supplier Ledger Inquiry form is the active window and highlight the grid area of the form.

2. Go to the Form menu and choose the Grid Columns option.

3. Using the Up, Down, and arrow buttons, make the Columns Selected window look like the following.  It does not matter what fields are below P.O. Number.
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4. Click OK to save the changes.

5. Click Close to go back to the Form Design Aid window.

Add An Update Button to the Data Entry Screen (B7.3.3.x)

1. One of the screens that is commonly used for the Update function is the Standard Voucher Entry screen.  Begin the process of adding a button to this screen by going into the Window menu on the Form Design Aid and selecting the Enter Voucher – Payment Information form.

2. Highlight &Row and click Add.  The Exit Properties Dialog opens.

3. In the Exit Properties window, Enter Update in the Short Text field.
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4. In the Long field enter Update IBPM.

5. Select Toolbar in the Type frame.  The State should be Enabled and Style should be Command.

6. Click OK.  The Exit Properties dialog closes.

Configure the Update IBPM Button (B7.3.3.x)

1. Highlight the new Update button by clicking anywhere in the row.

2. Click the Event Rules button.  The Event Rules design dialog opens.

3. Click the F(B) button in the Toolbar.  The Business Function Search dialog opens.

4. Type Pass* for the Function Name and click Find.  The three Business Functions are displayed. 

5. Select PassAPShortToIBPM by clicking the gray box on the right side of the dialog and clicking select or double clicking. The Business Functions dialog opens.

6. Map all fields as defined in the tables below.

Update IBPM Data Mappings (B7.3.3.x)

	Available Objects
	Data Item

	SL UserId
	Username

	Literal – W0411A
	ScreenName

	Literal – Update Invoice Package
	MapName

	Literal – 2
	ActionCode

	Literal – 04
	Module

	FC AddressNumber
	SupplierNumber

	FC Company
	Company

	FC Document Type
	InvoiceDocType

	FC Invoice Number
	InvoiceNumber

	GC Gross Amount
	InvoiceAmount

	FC Invoice Date
	InvoiceDate

	FC Business Unit
	BusinessUnit

	GC Remark
	PurchaseOrder

	FC Document Number
	DocumentNumber


7. After all the Values are assigned the direction of the flow of information must be assigned. In the Dir column, between the Value and Data Item columns, the current symbol (() represents No flow of information.

8. To complete the Value assignments, click on the box in each row until an arrow appears pointing to the right (().

9. Click OK.  The Business Functions Dialog closes.  The Event Rules Design dialog is active.

10. Click Save and Exit (the green check mark icon on the toolbar).  The Event Rules Design dialog closes.  The Menu/Toolbar Exits dialog is active.

11. Click Close. The Form Design Aid is active.

12. Click Save. The Validate Event Rules status indicator runs, performing a check on the input values.  The message Validation Successful is displayed at the end of the check if no problems were detected.

13. Click OK to close the Validate Event Rules window.  If errors are detected a log file will be displayed.  Correct the errors before continuing.  When the Form Design Aid is closed, the Object Librarian – Application Design Aid window is displayed.

14. Click OK.  The Object Librarian – Work with Object Librarian window is displayed.

15. Use the X in the upper right hand corner of the window to close the Object Librarian.

16. Close the entire OneWorld application and restart it for the changes to take affect.

Adding Sample Data To OneWorld (B7.3.3.x)

Sample data must be added to OneWorld for the demonstration to work. The following samples have been provided specifically for the demonstration of the integration between OneWorld and IBPM.

Add Address Book Entries (B7.3.3.x)

1. Open OneWorld. The OneWorld Sign On dialog opens.

2. Enter the Password.

3. Click OK. The J.D. Edwards OneWorld Explorer is displayed.  

4. Open Foundation Systems  ( Address Book  ( Daily Processing.  Word Search and Address Book Revisions are displayed in the Daily Processing folder.

5. Open Address Book Revisions.  The Address Book Revisions – [Work with Addresses] window opens.

6. Click Add on the toolbar.  The Address Book Revisions – [Address Book Revision] dialog opens.

7. Enter the Address Number 8483.

8. Enter the Alpha Name Bruce’s Bicycles.

9. Enter the Long Address Number 8483.

10. Enter the Tax ID 8483.

11. Enter the Search Type V.

12. Enter the numeral 1 in the Business Unit field.

13. Click OK. The information is updated in the OneWorld database. The Supplier Master Revision window is displayed.

14. Click OK.  The Address book Revision window is displayed ready for the next Address.

15. Using the table below repeat the process above entering the information for Joel’s Paint and Shaun’s Parts.

	Address Number
	Alpha Name
	Long Address Number
	Tax ID
	Search Type
	Business Unit

	8491
	Joel’s Paint
	8491
	8491
	V
	1

	8504
	Shaun’s Parts
	8504
	8504
	V
	1


16. When Shaun’s Parts has been entered and the last OK has been clicked (The Address Book Revision window is displayed) click Cancel to close the window. The Work with Addresses window is displayed.

17. Click Close.

Add Voucher Records (B7.3.3.x)

Starting at the OneWorld Explorer screen, drill down through the following menu options – Financials ( Accounts Payable ( Daily Processing ( Supplier & Voucher Entry ( Speed Voucher Entry.

1. Make sure there is an empty Speed Voucher Entry screen.

2. Enter 8491 in the Supplier Number field.

3. Enter 1 in the Company field.

4. Enter XYZ100 in the Invoice Number field.

5. Enter 25.00 in the Invoice Amount field.

6. Enter 8/11/99 in the Invoice Date field.

7. Enter 6/1/05 in the G/L Date field.

8. Enter 10335 OP in the PO No field.

9. Enter 1.1344 in the Account Number field.  The screen will look like the picture below.
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10. Click OK.  You will be back at an empty Speed Voucher Entry screen.  Start the entry for the second voucher record.

11. Enter 8491 in the Supplier ID field.

12. Enter 1 in the Company field.

13. Enter XYZ110 in the Invoice Number field.

14. Enter 81.50 in the Invoice Amount field.

15. Enter 8/16/99 in the Invoice Date field.

16. Enter 6/1/05 in the G/L Date field.

17. Enter 10335 OP in the PO No field.

18. Enter 1.1344 in the Account Number field.

19. Click OK.  You will be back at an empty Speed Voucher Entry window.

20. Click Cancel to return to the OneWorld Explorer window.

Configuring J.D. Edwards OneWorld (Xe)

There are two primary steps to configuring OneWorld – Adding and configuring the new objects and adding and configuring the functions on the forms.  The steps for adding the objects remain the same regardless of what solution is being installed, but the steps relating to the buttons and forms may change depending on the customers’ requirements. As of the Acorde Integration Tools 4.0 release, all the objects and data structures may be imported using a product called Boomerang by Pastuhov Computing.  The Boomerang Lite program is a free download from the following site:

http://members.optushome.com.au/apastuhov/downloads.htm
The Boomerang package file containing all objects is called:

Windows Integration-8.BG1

For details regarding using the Boomerang software, please refer to the EnterpriseOne Web Integration section of EIS.chm. 

After importing the Boomerang package, please skip to the section “Building OneWorld Business Function Objects”

To manually create all the objects and data structures, please follow the instructions precisely to use the demonstration script.  If you are configuring a production system, consult with your customer and their J.D. Edwards integrator before configuring OneWorld.

1. Open J.D. Edwards OneWorld from either the desktop shortcut or the Start Programs menu.  The OneWorld Sign on dialog is displayed.

2. Enter a User ID of DEMO.

3. Tab to the Password field. The database used in Demo Jr. is a Microsoft Access database and therefore, once the system has been initialized any characters in this field allow access to the database. Enter any alpha-numeric characters for the password.

4. The Environment field should be set to DEMOB73.

5. Click OK.

6. Throughout this process, the Just in Time Install window may appear as additional software is installed.  When complete, the OneWorld Explorer main menu is displayed.

Adding and Designing OneWorld Objects (Xe)

Stellent has prepared data structures and business functions for the Accounts Payable and Accounts Receivable modules.  There is also a Generic data structure and business function that can be used in any OneWorld module.

This is a list of all of the objects that could be added to the system if installing all three business functions.   It is not necessary to apply all of these objects if using one business function.

The names of the objects closely match the OneWorld naming convention, but these object names can be modified.  If the data structure object name is modified, then the new name will need to be updated into the .C and .H files, which contain the actual business function.  If the name of the business function object is changed then the name of the .C and .H files would also need to be changed.  Consult with Stellent or a J.D. Edwards integrator to change these object names or use a different data structure.

· OPTKBL
IBPM Business Function Library
BL
Business Function Library

· BOPTKAP
IBPM Business Function – AP Short 
BSFN
Business Function

· DOPTKAP
IBPM Data Structure  - AP Short
DSTR
Data Structure

· BOPTKAR
IBPM Business Function - AR Short
BSFN
Business Function

· DOPTKAR
IBPM Data Structure – AR Short
DSTR
Data Structure

· BOPTKGN
IBPM Business Function – GN Short
BSFN
Business Function

· DOPTKGN
IBPM Data Structure – GN Short
DSTR
Data Structure

Add the Business Function Library (BL) Object (Xe)

A Business Function Library is a shell in which Business Function (BSFN) objects are stored and compiled.   When compiled, the BL (Business Library) object becomes even more important. All the BSFN objects are compiled into one .dll file, which is located in the B7\[PATHCODE]\BIN32 directory.

The steps to add objects to OneWorld are very straightforward.  Begin the process by opening the Object Librarian.

1. Type OL in the Fast Path field in OneWorld Explorer.  The Object Management Workbench

2. Click the Find button to get a list of projects.

3. Highlight the project that needs to be modified.  In order to setup a demonstration, highlight the DEMO – Default Project.

4. Click the Add button.  The Add OneWorld Object to the Project, DEMO dialog opens.

5. Click the Business Function Library radio button.

6. Click the OK button.  The Add Object dialog opens.

7. Enter OPTKBL in the Object Name field.

8. Enter a description of IBPM Business Function Library.

9. Enter a Product Code of 58.

10. Enter a Product System Code of 58.

11. Enter 1 in the Object Use field.

12. Click OK in the toolbar.  The Object Management Workbench window reappears and the BL object has been added.

Add the Business Function (BSFN) Objects (Xe)

A business function is an encapsulated reusable routine that can be called through event rules.  Stellent has already created the routine (C program) that needs to be attached to this business function to keep the implementation straightforward.

1. Click the Add button on the Object Management Workbench window.  The Add OneWorld Object to the Project, DEMO dialog opens.

2. Click the Business Function radio button.

3. Click the OK button.  The Add Object dialog opens.

4. Enter BOPTKAP in the Object Name field.

5. Enter IBPM Business Function - AP Short into the description field.

6. Enter a Product Code of 58.

7. Enter a Product System Code of 58.

8. Enter 1 in the Object Use field.

9. Enter the Function Location of 2.

10. Click the radio button for C under Source Language.

11. Click OK in the toolbar.  The Object Management Workbench window reappears and the BSFN object has been added.

12. Repeat steps 1 – 11 of this section for the other two business functions objects.  Only the Object Name and the Descriptions change.  All other information should be entered as defined above.

	Object
	Description.

	BOPTKAR
	IBPM Business Function - AR Short

	BOPTKGN
	IBPM Business Function - Generic Short


Add the Data Structure (DSTR) Objects for (Xe)

Business Function Data Structures are required and linked to the business functions described above.  Stellent has defined three data structures.  The number of fields in the data structures has been optimized to balance the normally required fields with the amount of time necessary to implement the data structure.  Stellent also built in some generic fields for flexibility.  If for some reason these data structures do not work in a particular implementation, please contact Stellent.

1. Click the Add button on the Object Management Workbench window.  The Add OneWorld Object to the Project, DEMO dialog opens.

2. Click the Data Structure radio button.

3. Click the OK button.  The Add Object dialog opens.

4. Enter DOPTKAP in the object name field.

5. Enter a description of IBPM Data Structure - AP Short.

6. Enter a Product Code of 58.

7. Enter a Product System Code of 58.

8. Enter 360 in the Object Use field.

9. Click OK in the toolbar.  The Object Management Workbench window reappears and the DSTR object has been added.

10. Repeat steps 1 – 9 of this section for the other two data structure objects.  Only the Object Name and the Descriptions change. All other information should be entered as defined above.

	Object
	Description

	DOPTKAR
	IBPM Data Structure - AR Short

	DOPTKGN
	IBPM Data Structure - Generic Short


Design the Business Function (BSFN) Objects for (Xe)

The objects have been created now they need to be designed.  This section describes the process of designing the business functions.  This process begins in the Object Management Workbench window.

1. Expand the tree view on the project that is being modified until the Objects are visible.

2. Highlight the BOPTKAP record.

3. Click the Design button on the toolbar that goes down the middle of the window.  The Business Function Design window opens.

4. Click on the Design Tools tab.

5. Click on the Start Business Function Design button.

6. Enter OPTKBL in the Parent DLL text box.

7. Leave the Business Function Location at 2.

8. Enter PassAPShortToIBPM in the Function Name field in the table.  Press Tab.

9. Enter Pass AP Short Structure to IBPM in the description field.  Press Tab.

10. Enter APP in the Function Category field.  This can either be entered directly or searched for using the Search function provided in the field.  Press Tab.

11. Don’t put anything in the Function Use field.  Press Tab.

12. Enter the numeral 3 in the F3 Code field.  Press Tab.  You are now on the Template Name field.

13. Highlight the row by selecting the gray box on the left of the row.

14. Go into the Preferences menu option and verify that the Exit Row option is checked.

15. Select Parameters from the Row Exit menu or the Parameters button in the Row Exit.  The Select Business Function Parameters dialog opens.

16. Search for the data structure by putting DOPTKAP in the Source Module column and press Enter.

17. Double click on the DOPTKAP record when it is returned to make your parameter selection complete.  The Object Librarian – Business Function Design screen is displayed and the Template Name field will be populated with DOPTKAP.

18. Click OK.  The Object Management Workbench – [Business Function Design] window.

19. Click OK to return to the Object Management Workbench main window.  This will save the changes made to the Business Function.

20. Repeat steps 1- 19 of this section for the other two business functions.   Only the function name, description, and data structure change.

	Function Name
	Description
	Data Structure

	PassARShortToIBPM
	Pass AR Short Structure to IBPM
	DOPTKAR

	PassGNShortToIBPM
	Pass GN Short Structure to IBPM
	DOPTKGN


Design the Data Structure (DSTR) Objects (Xe)

The data structure objects have been created, now they need to be designed.  This section describes the process of designing the business functions.  This process begins with the Object Management Workbench window.

1. Expand the tree view on the project that is being modified until the Objects are visible.

2. Highlight the DOPTKAP record.

3. Click the Design button on the toolbar that goes down the middle of the window.  The Data Structure Design window opens.

4. Click on the Design Tools tab.

5. Click on the Data Structure Design button.  The Data Structure: IBPM Data Structure AP Short window appears.  This window allows the data structure to be built by selecting items on the right in the Dictionary Items field and dragging them to the Structure Member Field on the left.

6. In the Dictionary Items section, scroll to the right until the Alias field is exposed.

7. Enter the first Alias (USER) in the Yellow field above Alias and press enter. The Dictionary Item with the Alias of User is returned.

8. Drag the User Dictionary Item to the left hand window, Structures Members, and then drop it near the top of the window under the column headings. The Dictionary Item with Alias of User now occupies the first row in the Structure Members table and is its Structure Member name of szUserId is displayed.

9. Double click on the field in the column Structure Member (szUserId) and replace that name with the Stellent field name of Username.

10. Repeat the process for all the Aliases in the following table by dragging them below the existing Structure Members.  Once the Structure Member table becomes full, drop the remaining structure members in the horizontal scroll bar as seen in the picture below.  The data structure must be entered in the exact order documented here.
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	DOPTKAP

Structure Member
	OneWorld

Data Item
	OneWorld

Alias
	OneWorld

Data Type
	OneWorld

Field Size

	Username
	UserId
	USER
	String 
	10

	ScreenName
	DescriptionAlpha
	DSCA
	String 
	40

	MapName
	DescriptionAlpha
	DSCA
	String 
	40

	ActionCode
	ActiontobePerformed
	ACN
	Char 
	1

	Module
	DescriptionAlpha
	DSCA
	String 
	40

	SupplierNumber
	Address Number
	AN8
	Number
	8

	Company
	Company
	CO
	String 
	5

	InvoiceDocType
	DocumentType
	DCT
	String 
	2

	InvoiceNumber
	VendorInvoiceNumber
	VINV
	String 
	25

	InvoiceAmount
	AmountGross
	AG
	Number
	15

	InvoiceDate
	DateInvoiceJ
	DIVJ
	Date
	6

	BusinessUnit
	BusinessUnit
	94U
	String 
	12

	PurchaseOrder
	PurchaseOrder
	PO
	String 
	8

	DocumentNumber
	DocVoucherInvoiceE
	DOC
	Number
	8

	CheckNumber
	CkControlNoAPCh
	CKC
	Number
	8

	CheckDate
	DateCheck
	CKD
	Date
	6

	CheckAmount
	AmountCheckAmount
	CKAM
	Number
	15

	GenericNumeric1
	GenericNumeric1
	GNUM1
	Number
	15

	GenericNumeric2
	GenericNumeric2
	GNUM2
	Number
	15

	GenericNumeric3
	GenericNumeric3
	GNUM3
	Number
	15

	GenericDate1
	JulianDate
	JDATE
	Date
	6

	GenericDate2
	JulianDate
	JDATE
	Date
	6

	GenericDate3
	JulianDate
	JDATE
	Date
	6

	GenericString1
	GenericText
	TXT0
	String 
	80

	GenericString2
	GenericText
	TXT0
	String 
	80

	GenericString3
	GenericText
	TXT0
	String 
	80


11. Click OK after all the fields have been entered in the sequence it appears in the table. The Object Management Workbench – [Data Structure Design] window appears.

12. Click OK.  The main Object Management Workbench window appears.

13. Repeat steps 1-12 for the other two data structure objects.  Use the tables below.

The following table is for the DOPTKAR (IBPM Data Structure - AR Short) only.

	DOPTKAR
	OneWorld
	OneWorld
	OneWorld
	OneWorld

	Structure Member
	Data Item
	Alias
	Data Type
	Field Size

	Username
	UserId
	USER
	String 
	10

	ScreenName
	DescriptionAlpha
	DSCA
	String 
	40

	MapName
	DescriptionAlpha
	DSCA
	String 
	40

	ActionCode
	ActiontobePerformed
	ACN
	Char 
	1

	Module
	DescriptionAlpha
	DSCA
	String 
	40

	Company
	Company
	CO
	String 
	5

	CustomerNumber
	Address Number
	AN8
	Number
	8

	DocumentType
	DocumentType
	DCT
	String 
	2

	GrossAmount
	AmountGross
	AG
	Number
	15

	InvoiceDate
	DateInvoiceJ
	DIVJ
	Date
	6

	BusinessUnit
	BusinessUnit
	94U
	String 
	12

	PONumber
	PurchaseOrder
	PO
	String 
	8

	GenericNumeric1
	GenericNumeric1
	GNUM1
	Number
	15

	GenericNumeric2
	GenericNumeric2
	GNUM2
	Number
	15

	GenericNumeric3
	GenericNumeric3
	GNUM3
	Number
	15

	GenericDate1
	JulianDate
	JDATE
	Date
	6

	GenericDate2
	JulianDate
	JDATE
	Date
	6

	GenericDate3
	JulianDate
	JDATE
	Date
	6

	GenericString1
	GenericText
	TXT0
	String 
	80

	GenericString2
	GenericText
	TXT0
	String 
	80

	GenericString3
	GenericText
	TXT0
	String 
	80


The following table is for the DOPTKGN (IBPM Data Structure - Generic Short) only.

	DOPTKGN
	OneWorld
	OneWorld
	OneWorld
	OneWorld

	Structure Member
	Data Item
	Alias
	Data Type
	Field Size

	Username
	UserId
	USER
	String 
	10

	ScreenName
	DescriptionAlpha
	DSCA
	String 
	40

	MapName
	DescriptionAlpha
	DSCA
	String 
	40

	ActionCode
	ActiontobePerformed
	ACN
	Char 
	1

	Module
	DescriptionAlpha
	DSCA
	String 
	40

	AddressNumber
	Address Number
	AN8
	Number
	8

	GenericNumeric1
	GenericNumeric1
	GNUM1
	Number
	15

	GenericNumeric2
	GenericNumeric2
	GNUM2
	Number
	15

	GenericNumeric3
	GenericNumeric3
	GNUM3
	Number
	15

	GenericDate1
	JulianDate
	JDATE
	Date
	6

	GenericDate2
	JulianDate
	JDATE
	Date
	6

	GenericDate3
	JulianDate
	JDATE
	Date
	6

	GenericString1
	GenericText
	TXT0
	String 
	80

	GenericString2
	GenericText
	TXT0
	String 
	80

	GenericString3
	GenericText
	TXT0
	String 
	80


Building OneWorld Business Function Objects for (Xe)

The Business Function Objects have been defined.  Now we need to compile the actual source code and data structure elements into the J.D. Edwards OneWorld environment.  The following steps may be different for a production OneWorld system.

Copy Source Files (Xe)

If objects and data structures are imported from Boomerang package, all source files are placed in the correct folder. Please continue to the next step.

For the OneWorld demo Jr. system, there are six source files that must be copied by the developer from the OneWorldBusinessFunctions directory on the EIS CD to the install directory for the J.D. Edwards OneWorld Directories.

1. Copy the *.C files (BOPTKAP.C, BOPTKAR.C and BOPTKGN.C) to the \\B7\Demo\Source directory from the OneWorldBusinessFunctions directory on the CD.

2. Copy the *.H files (BOPTKAP.H, BOPTKAR.H, BOPTKGN.H) to the \\B7\Demo\Include directory from the OneWorldBusinessFunctions directory on the CD.

Rebuild Libraries (Xe)

Once the files are in place, then a library build must be performed.  The OneWorld program called BusBuild.EXE is used to perform this task and it is located in \\B7\System\Bin32.

1. Make sure the OneWorld application is closed.

2. Activate the BusBuild.EXE using Run from the Start menu or browsing and double clicking in Windows Explorer.

3. The BusBuild program will prompt you to log in the first time it is run.  Use the same login and password that was used to login to OneWorld.

4. Click on the Build drop down menu.

5. Click Rebuild Libraries in the Build drop down menu.  The Build Output dialog displays, reporting the progress of the build. The compile process time can take several minutes.  The compile Process is complete when the cursor is blinking at the bottom of the build field.

6. Scroll through the Build Output and find the following entries.

Generating Makefile: D:\B7\DEMO\obj\OPTKBL.mak

Makefile generated.

************OPTKBL************

jdertdll.c

Creating library D:\B7\DEMO\lib32\OPTKBL.lib and object D:\B7\DEMO\lib32\OPTKBL.exp

Rebased at 0x620E0000 : D:\B7\DEMO\bin32\OPTKBL.dll

Image processed by BindImage. 

OPTKBL.dll   -   0 error(s),    0 warning(s):  Built successfully. 

7. Make sure the OPTKBL.DLL is listed as having compiled successfully – 0 errors before continuing.

8. Close BusBuild by clicking on the X in the upper right hand corner of the dialog or clicking Exit from the File menu.

Build the Business Functions (Xe)

The last step in preparing the business functions for use is the Build that happens inside of OneWorld.

1. Log into J.D. Edwards OneWorld and open the Object Management Workbench (type OL in the fast path and press Enter).

2. Click the Find button to get a list of projects.

3. Expand the tree view on the project that is being modified until the Objects are visible.

4. Highlight the BOPTKAP record.

5. Click the Design button on the toolbar that goes down the middle of the window.  The Business Function Design window opens.

6. Click on the Design Tools tab.

7. Click the Build Business Function button.  The BusBuild.EXE launches and compiles the object.  OPTKBL.dll – 0 errors, 0 – warnings, Build Successful is announced when the compile is complete.

8. Close BusBuild by clicking on the X in the upper right hand corner of the dialog or clicking Exit from the File menu.  The Business Function Design window becomes the active window.

9. Click OK.   The main Object Management Workbench window appears.

10. Repeat Steps 3 – 9 for the objects BOPTKAR (IBPM Business Function – AR Short) and BOPTKGN (IBPM Business Function – Generic Short).

Adding the Enabling Buttons to the OneWorld Forms (Xe)

The first step in this process is to identify which OneWorld Job runs the form to be modified.  Next to the description in the OneWorld Explorer interface, find the Job to Execute column.  The Standard Voucher Entry program, which is part of the Accounts Payable solution that Stellent has created, has a Job to Execute of P0411.  This process begins with the Object Management Workbench window.

1. Highlight the DEMO Project in the left hand panel of the main Object Management Workbench window.

2. Click the Search tab in the right hand panel of the main Object Management Workbench window.

3. Type P0411 in the Search field.

4. Click the magnify glass / Search button.  A tree view is displayed in the lower section of the panel.

5. Highlight the P0411 - AP Standard Voucher Entry record.

6. Click the Add Object or User to Project (Arrow) button on the toolbar that goes down the middle of the window.  The P0411 application is added to the DEMO Project.

7. Highlight the P0411 record.

8. Click the Design button on the toolbar that goes down the middle of the window.  The Interactive Application Design window opens.

9. Click on the Design Tools tab.

10. Click on the Start Form Design Aid button.  A warning is displayed that says “This object is not checked out.  Are you sure you would like to continue?”

11. Click the Yes button.  The Form Design Aid window appears.

Add Search Buttons to the OneWorld Forms (Xe)

1. One of the forms in the P0411 program is Supplier Ledger Inquiry. Using the Windows Menu option, make it the active window.

2. Select Form from the main dialog menu bar and choose Menu/Toolbar Exits. The Menu/Toolbar Exits dialog opens.

3. Highlight &Row and click Add.  The Exit Properties Dialog opens.  In the Exit Properties window, enter Search Invoice in the Short Text field.

4. In the Long field enter Search for Invoice.

5. Select Toolbar in the Type frame.  The State should be Enabled.

6. Click OK to close the Exit Properties dialog box.

7. Repeat steps 16 through 19 using the following table to provide the guidelines for each menu addition.  Click OK after the information has been entered for each of the menu items.

	Short Text
	Long Text
	Type

	Search Supplier
	Search by Supplier Number
	Toolbar

	Search IBPM
	Search IBPM
	Toolbar


The Menu/Toolbar Exits window should look like the following.
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Configure the Search Buttons (Xe)

1. Highlight the Search for Invoice row in the Menu/Toolbar Exits window and select the Event Rules button.  The Event Rules design dialog opens.

2. Select F(B) button in the Toolbar.  The Business Function Search dialog opens.

3. Enter Pass* for the Function Name and click Find.  The three Business Functions configured previously are displayed.

4. Double click on the highlighted record (PassAPShortToIBPM) in the Function Name Column or highlight by clicking on the gray box to the right of the row and clicking Select. The Business Functions dialog displays.

5. Three columns are viewable, Available objects, Value and Data Item.  Available objects are the objects, which can be assigned to the Data Items. Values show the Available objects that have been assigned.

6. To move an object from the Available objects column to the Value column click the Value cell where the Available Object is to be assigned.

7. Select the Available object by double clicking the item or select the desired item and use the arrows between the columns to move the Available object.  Use the following table to assign Available Objects to the Value for the appropriate Data Item.

Search by Invoice Data Mappings

	Available Objects
	Data Item

	SLUserId
	Username

	Literal – W0411G
	ScreenName

	Literal – Invoice by Inv Num and Supp ID
	MapName

	Literal – 1
	ActionCode

	Literal – 04
	Module

	GC SupplierNumber
	SupplierNumber

	GC Co
	Company

	GC DocType
	InvoiceDocType

	GC InvoiceNumber
	InvoiceNumber

	GC Gross Amount
	InvoiceAmount

	GC InvoiceDate
	InvoiceDate

	GC BusinessUnit
	BusinessUnit

	GC PurchaseOrder
	PurchaseOrder

	GC DocumentNumber
	DocumentNumber


When this table is complete, several Data Items will not have assigned values like Check Number, Check Date, etc., these fields are not used on this particular screen.

The fields labeled Generic provided at the bottom of the Data Items column have been created to provide an area to pass data specific to a customer’s implementation.  All fields not specifically referred to in this explanation can maintain a Value of NOT Assigned.

8. After all the Values are assigned, the direction of the flow of information needs to be assigned.  In the Dir column, between the Value and Data Item columns, the current (() symbol represents No flow of information.  To complete the Value assignments the flow of information must be from the Value to the Data Item. Accomplish this by clicking on the box in each mapped row until an arrow appears pointing to the right (().  Rows that have <NOT Assigned> do not need to have the direction arrow adjusted.

9. Click OK.  The Business Functions Dialog closes.  The Event Rules Design dialog is active.

10. In the Options Menu make sure Repeat for Grid is checked.

11. Click the Save and Exit button, which is the green check mark icon on the toolbar.  The Event Rules Design dialog closes.  The Menu/Toolbar Exits dialog is active.

12. Repeat the steps on Configuring Search Buttons for the Search by Supplier and Search IBPM menu items.  Use the following tables to establish the data mappings.  Basically all the fields are the same for all of the Search buttons except the MapName literal.  Don’t forget to set the Repeat for Grid option.

Search by Supplier Data Mappings

	Available Objects
	Data Item

	SLUserId
	Username

	Literal – W0411G
	ScreenName

	Literal – All Docs by Supplier ID
	MapName

	Literal – 1
	ActionCode

	Literal – 04
	Module

	GC SupplierNumber
	SupplierNumber

	GC Co
	Company

	GC DocType
	InvoiceDocType

	GC InvoiceNumber
	InvoiceNumber

	GC Gross Amount
	InvoiceAmount

	GC InvoiceDate
	InvoiceDate

	GC BusinessUnit
	BusinessUnit

	GC PurchaseOrder
	PurchaseOrder

	GC DocumentNumber
	DocumentNumber


Search IBPM Data Mappings

	Available Objects
	Data Item

	SLUserId
	Username

	Literal – W0411G
	ScreenName

	Literal – Blank
	MapName

	Literal – 1
	ActionCode

	Literal – 04
	Module

	GC SupplierNumber
	SupplierNumber

	GC Co
	Company

	GC DocType
	InvoiceDocType

	GC InvoiceNumber
	InvoiceNumber

	GC Gross Amount
	InvoiceAmount

	GC InvoiceDate
	InvoiceDate

	GC BusinessUnit
	BusinessUnit

	GC PurchaseOrder
	PurchaseOrder

	GC DocumentNumber
	DocumentNumber


13. When these steps are all done, click Close in the Menu/Toolbar Exits window.

14. Before moving on to the next screen, adjust the columns in the Supplier Ledger Inquiry.

Adjust the Columns in the Supplier Ledger Inquiry Grid (Xe)

1. While in the J.D. Edwards Form Design Aid for P0411, make sure that the Supplier Ledger Inquiry form is the active window and highlight the grid area of the form.

2. Go to the Form menu and choose the Grid Columns option.

3. Using the Up, Down, and arrow buttons, make the Columns Selected window look like the following.  It does not matter what fields are below P.O. Number.

[image: image8.png]Grid Column Layout for Voucher Document Review

Colurnns Available Colurnns Selected
Column - Column =

[Docurnent Company | [Buptier Number 7

Docurment Number ivoice Nurmber

Dociment Type Gross Amount

Fay liern ociment Nurmber

Fayitem Extension Number

Kl |
/0K | Data sort| X close

<
g
E
=
3





4. Click OK to save the changes.

5. Click Close to go back to the Form Design Aid window.

Add An Update Button to the Data Entry Screen (Xe)

1. One of the screens that is commonly used for the Update function is the Standard Voucher Entry screen.  Begin the process of adding a button to this screen by going into the Window menu on the Form Design Aid and selecting the Enter Voucher – Payment Information form.

2. Highlight &Row and click Add.  The Exit Properties Dialog opens.

3. In the Exit Properties window, Enter Update in the Short Text field.
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4. In the Long field enter Update IBPM.

5. Select Toolbar in the Type frame.  The State should be Enabled and Style should be Command.

6. Click OK.  The Exit Properties dialog closes.

Configure the Update IBPM Button (Xe)

1. Highlight the new Update button by clicking anywhere in the row.

2. Click the Event Rules button.  The Event Rules design dialog opens.

3. Click the F(B) button in the Toolbar.  The Business Function Search dialog opens.

4. Type Pass* for the Function Name and click Find.  The three Business Functions are displayed. 

5. Select PassAPShortToIBPM by clicking the gray box on the right side of the dialog and clicking select or double clicking. The Business Functions dialog opens.

6. Map all fields as defined in the tables below.

Update IBPM Data Mappings

	Available Objects
	Data Item

	SL UserId
	Username

	Literal – W0411A
	ScreenName

	Literal – Update Invoice Package
	MapName

	Literal – 2
	ActionCode

	Literal – 04
	Module

	FC AddressNumber
	SupplierNumber

	FC Company
	Company

	FC Document Type
	InvoiceDocType

	FC Invoice Number
	InvoiceNumber

	GC Gross Amount
	InvoiceAmount

	FC Invoice Date
	InvoiceDate

	FC Business Unit
	BusinessUnit

	GC Remark
	PurchaseOrder

	FC Document Number
	DocumentNumber


7. After all the Values are assigned the direction of the flow of information must be assigned. In the Dir column, between the Value and Data Item columns, the current symbol (() represents No flow of information.

8. To complete the Value assignments, click on the box in each row until an arrow appears pointing to the right (().

9. Click OK.  The Business Functions Dialog closes.  The Event Rules Design dialog is active.

10. Click Save and Exit (the green check mark icon on the toolbar).  The Event Rules Design dialog closes.  The Menu/Toolbar Exits dialog is active.

11. Click Close. The Form Design Aid is active.

12. Click Save. The Validate Event Rules status indicator runs, performing a check on the input values.  The message Validation Successful is displayed at the end of the check if no problems were detected.

13. Click OK to close the Validate Event Rules window.  If errors are detected a log file will be displayed.  Correct the errors before continuing.  When the Form Design Aid is closed, the Object Management Workbench – [Interactive Application Design] window is displayed.

14. Click OK.  The main Object Management Workbench window appears.

15. Click on the File menu and then the Close menu option to exit out of the Object Management Workbench.

16. Close the entire OneWorld application and restart it for the changes to take affect.

Adding Sample Data To OneWorld (Xe)

Sample data must be added to OneWorld for the demonstration to work. The following samples have been provided specifically for the demonstration of the integration between OneWorld and IBPM.

Add Address Book Entries (Xe)

1. Open OneWorld. The OneWorld Sign On dialog opens.

2. Enter the Password.

3. Click OK. The J.D. Edwards OneWorld Explorer is displayed.  

4. Open Foundation Systems ( Address Book ( Daily Processing.  Word Search and Address Book Revisions are displayed in the Daily Processing folder.

5. Open Address Book Revisions.  The Address Book Revisions – [Work with Addresses] window opens.

6. Click Add on the toolbar.  The Address Book Revisions – [Address Book Revision] dialog opens.

7. Enter the Address Number 8483.
8. Enter the Alpha Name Bruce’s Bicycle. 

9. Enter the Long Address Number 8483.

10. Enter the Search Type V.

11. Enter the numeral 1 in the Business Unit field.

12. Click OK. The information is updated in the OneWorld database. The Supplier Master Revision window is displayed.

13. Click OK.  The Address book Revision window is displayed ready for the next Address.

14. Using the table below repeat the process above entering the information for Joel’s Paint and Shaun’s Parts.

	Address Number
	Alpha Name
	Long Address Number
	Search Type
	Business Unit

	8491
	Joel’s Paint
	8491
	V
	1

	8504
	Shaun’s Parts
	8504
	V
	1


15. When Shaun’s Parts has been entered and the last OK has been clicked (The Address Book Revision window is displayed) click Cancel to close the window. The Work with Addresses window is displayed.

16. Click Close.

Add Voucher Records (Xe)

Starting at the OneWorld Explorer screen, drill down through the following menu options – Financials ( Accounts Payable ( Daily Processing ( Supplier & Voucher Entry ( Speed Voucher Entry.

1. Make sure there is an empty Speed Voucher Entry screen.

2. Enter 8491 in the Supplier Number field.

3. Enter 1 in the Company field.

4. Enter XYZ100 in the Invoice Number field.

5. Enter 25.00 in the Invoice Amount field.

6. Enter 8/11/99 in the Invoice Date field.

7. Enter 6/1/05 in the G/L Date field.

8. Enter 10335 OP in the PO No field.

9. Enter 1.1344 in the Account Number field.  The screen will look like the picture below.
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10. Click OK.  You will be back at an empty Speed Voucher Entry screen.  Start the entry for the second voucher record.

11. Enter 8491 in the Supplier ID field.

12. Enter 1 in the Company field.

13. Enter XYZ110 in the Invoice Number field.

14. Enter 81.50 in the Invoice Amount field.

15. Enter 8/16/99 in the Invoice Date field.

16. Enter 6/1/05 in the G/L Date field.

17. Enter 10335 OP in the PO No field.

18. Enter 1.1344 in the Account Number field.

19. Click OK.  You will be back at an empty Speed Voucher Entry window.

20. Click Cancel to return to the OneWorld Explorer window.

Configuring IBPM
Creating IBPM Applications

IBPM applications are used to store document indexes and objects.  The tables below define the fields and parameters for each Application Definition.  The Application Field Names listed below are used in other parts of this documentation (i.e. Saved Searches and Mappings) so if alternate field names are used, then the other areas of the document that specify these field names will also need to be adjusted.  For more information about creating application definitions see the IBPM.chm help files.

Stellent has pre-defined seven Accounts Payable applications.  The integration does not require these exact applications to run, but they can be used to expedite the implementation of an Accounts Payable system or these applications can be used to setup a demonstration system.  Sample data is included that match these applications.

Sample Data Files

Sample data including images, reports, universal files, and Filer input files are provided by Stellent and need to be copied to the Filer input and images directories.

After installation, the sample data is located on the DSMS server in the Samples directory under SourceFiles.  The key directories are Input and Images.  The input files are pre-built to look at the C:\DB\Image and C:\DB\Input directories.  If different directories are used, then the input files need to be modified.

The files may have to be changed from Read-Only after they have been installed.

Sample Database

Stellent has included a sample database with all seven of the following applications already defined.  The sample database also has the Saved Searches setup already.  Following are the steps for putting the sample database on to a demo system.  If you do not wish to utilize the sample database but would like to utilize the sample data, then you can proceed to the Application Definition section of this document.

These instructions are only for Microsoft SQL Server.  If using another database type and the sample applications are to be used, key them into Filer using the instructions below.

1. The sample database files are placed into Program Files\ DSMS\Sourcefiles\Samples\DB directory by the installation process.  They are called SummitDemo_Data.MDF and SummitDemo_Log.LDF.  They need to be copied to the data directory used by SQL Server, which is usually C:\MSSQL7\Data.

2. Run SQL Server Query Analyzer from a workstation that can connect to the SQL Server.

3. Connect to the SQL Server Master database with the appropriate Username and Password.

4. In the New Query window, type the following command:

EXEC sp_attach_db @dbname = N'summitdemo', 

    

@filename1 = N'c:\mssql7\data\SummitDemo_Data.mdf', 

    

@filename2 = N'c:\mssql7\data\SummitDemo_Log.ldf'

5. If the SQL Server already has a database named SummitDemo, change the value after the N in the above command to a unique database value before continuing.

6. Click the Execute Query button.  The SQL Server will return the message Successfully attached database SummitDemo.

7. Exit from the Query Analyzer.

8. Create an ODBC source to point at this new database name.

9. Run the Information Broker Wizard to configure the ODBC source that was just created.

10. Run the Database Management Wizard to upgrade the database to version 9.

11. Configure the IBPM Link Provider with the names IMG and COLD pointing to the new databases.

12. Copy the input files and images from the CD.  These are located on the CD in Program Files\ DSMS\Sourcefiles\Samples\Input and Program Files\ DSMS\Sourcefiles\Samples\Images. Copy the contents of the Input directory to the Filer Input folder.  Copy the contents of the Images directory to c:\DB\Images.

13. Remove the Read Only attribute from the Input and Images files using Explorer.

14. When this database is connected to IBPM, File the sample data into the pre-defined IBPM applications.

15. The sample database uses the Storage Class name SC1 under the “disc” directory.  Make sure that a storage class of the same name exists on your system.

16. Setup security for these Saved Searches and proceed to the Implementing Workflow Process Files step.

17. Notes – Before Filing the sample data, it is necessary to modify the Application definition to include the username and password for the specific database being used.  It is also necessary to grant security to the groups that will be using these applications.

Contracts Application

Application Definition

	PRIVATE
Application:
Name: CONTRACT
Description: Contract Application
Classification Type: Archive
	Input File:
File Name: JDECONTS.DAT
Type: IMAGING
	Output:
Type: IMAGING-ODBC
User ID: Enter the UserID with access to the database
Password: Enter the Password with access to the database.
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Field Definitions

Index Definition

1. Create an Index named MAIN.

2. Include the defined fields in the following order: SupplierID, ContractDate, and DocType.

3. Mark all fields as searchable.

Invoice Application

Application Definition

	PRIVATE
Application:
Name: INVOICE
Description: Invoice Application
Classification Type: Archive
	Input File:
File Name: JDEINVS.DAT
Type: IMAGING
	Output:
Type: IMAGING-ODBC
User ID: Enter the User ID with access to the database.
Password: Enter the User ID with access to the database.
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Index Definition

1. Create an Index named MAIN.

2. Include the defined fields in the following order: SupplierID, InvoiceNumber, InvoiceDate, InvoiceAmount, PONumber, DocumentID, and DocType.

3. Mark all fields as searchable.

Purchase Order Application

Application Definition

	PRIVATE
Application:
Name: PO
Description: Purchase Order Application
Classification Type: Archive
	Input File:
File Name: JDEPOS.DAT
Type: IMAGING
	Output:
Type: IMAGING-ODBC
User ID: Enter the UserID with access to the database.
Password: Enter the UserID with access to the database.
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Index Definition

1. Create an Index named MAIN.

2. Include the defined fields in the following order: SupplierID, PODate, POAmount, PONumber, and DocType.

3. Mark all fields as searchable.

Packing Slip Application

Application Definition

	PRIVATE
Application:
Name: PACKSLIP
Description: Packing Slip Application
Classification Type: Archive
	Input File:
File Name: JDEPSS.DAT
Type: IMAGING
	Output:
Type: IMAGING-ODBC
User ID: Enter the User ID with access to the database.
Password: Enter the UserID with access to the database.
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Index Definition

1. Create an Index named MAIN.

2. Include the defined fields in the following order: SupplierID, PONumber, PSDate, and DocType.

3. Mark all fields as searchable.

Payment Edit Group Report Application

Application Definition

	PRIVATE
Application:
Name: PAYGROUP
Description: Payment Group Edit Report
Classification Type: Archive
	Input File:
File Name: JDEPAYGR.TXT
Type: TEXT
	Output:
Type: COLD-CIndex


Field Definitions

The number of exposed columns must be increased before all of the data on this report can be accessed.  Using the Align Report button on the Fields tab, change the COLS value to 200 and save the settings.
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Index Definition

1. Create an Index named MAIN.

2. Include the defined fields in the following order: SupplierID, InvoiceNumber, ReportDate, DueDate, Doc Type.

3. Mark all fields as searchable.

Check Stub Application

Application Definition

	Application Name: CHECKSTUB
Description: Check Stub Application

Classification Type: Archive
	Input File:
File Name: JDECSS.DAT 
Type: IMAGING
	Output:
Type: IMAGING-ODBC
User ID: Enter the User ID with access to the database.
Password: Enter the UserID with access to the database.
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Field Definitions

Index Definition

1. Create an Index named MAIN.

2. Include the defined fields in the following order: SupplierID, CheckDate, CheckNumber, CheckAmount, and DocType.

3. Mark all fields as searchable.

Report Application

Application Definition

	Application Name: REPORT
Description: Reports Application

Classification Type: Archive
	Input File:
File Name: JDERPTS.DAT
Type: IMAGING
	Output:
Type: IMAGING-ODBC
User ID: Enter the User ID with access to the database.
Password: Enter the UserID with access to the database.
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Index Definition

1. Create an Index named MAIN.

2. Include the defined fields in the following order: ReportName, ReportDate, and ReportTitle.

3. Mark all fields as searchable.

Creating IBPM Saved Searches

The J.D. Edwards OneWorld Integration uses Saved Searches to access data and documents from IBPM.  Saved Searches are created in the IBPM Search Builder Tool.  Please reference the IBPM.CHM help file for more details on Saved Searches or how to use the Search Builder Tool.

Stellent has pre-defined nine Searches.  Seven of these searches are specifically designed to test the successful filing of one of the pre-defined applications.  The other two Searches are part of the pre-defined Accounts Payable solution.  The integration does not require these Searches to run, but they can be used to expedite the implementation of an Accounts Payable system or they can be used to setup a demonstration system.  Sample data is included that match these Searches.

If any of the field names in the pre-defined applications were modified, those field names also need to be adjusted in the corresponding Search definition.  Proceed to the next section if using the pre-defined Saved Searches is not desired.

Each Search created for the installation of the J.D. Edwards OneWorld integration should conform to the specific settings identified below.  Any of the settings not specified can be set to meet individual preferences.

All Docs by Supplier ID

The table below provides the specific instructions necessary to create the All Docs by Supplier ID Saved Search.  This search is used in the pre-defined Accounts Payable solution to retrieve all of the documents indexed with the provided Supplier ID.

Application

	Selected Applications:
	CHECKSTUB.MAIN

CONTRACT.MAIN

INVOICE.MAIN

PACKSLIP.MAIN
PO.MAIN

PAYGROUP


Results Fields

	Selected Fields:
	Column Header:

	INVOICE.MAIN.SupplierID
	SupplierID

	PACKSLIP.MAIN.SupplierID
	SupplierID

	PO.MAIN.SupplierID
	SupplierID

	CHECKSTUB.MAIN.SupplierID
	SupplierID

	CONTRACT.MAIN.SupplierID
	SupplierID

	PAYGROUP.MAIN.SupplierID
	SupplierID

	INVOICE.MAIN.DocType
	DocType

	PACKSLIP.MAIN.DocType
	DocType

	PO.MAIN.DocType
	DocType

	CHECKSTUB.MAIN.DocType
	DocType

	CONTRACT.MAIN.DocType
	DocType

	PAYGROUP.MAIN.DocType
	DocType

	INVOICE.MAIN.InvoiceNumber
	Invoice Num

	PAYGROUP.MAIN.InvoiceNumber
	Invoice Num

	PO.MAIN.POAmount
	Amount

	CHECKSTUB.MAIN.CheckAmount
	Amount

	INVOICE.MAIN.InvoiceAmount
	Amount

	PO.MAIN.PODate
	Date

	INVOICE.MAIN.InvoiceDate
	Date

	PACKSLIP.MAIN.PSDate
	Date

	CONTRACT.Main.ContractDate
	Date

	CHECKSTUB.MAIN.CheckDate
	Date

	PAYGROUP.MAIN.DueDate
	Date

	PO.MAIN.PONumber
	PO Num

	INVOICE.MAIN.PONumber
	PO Num

	PACKSLIP.MAIN.PONumber
	PO Num

	CHECKSTUB.MAIN.CheckNumber
	Check Num

	INVOICE.MAIN.DocID
	Doc ID



Search Criteria

	Field List
	Compare
	Value
	And/Or
	Variable
	Search Form

	INVOICE.MAIN.SupplierID
	=
	
	And
	SuppID
	Prompt

	CONTRACT.MAIN.SupplierID
	=
	@SuppID
	And
	
	Hide

	CHECKSTUB.MAIN.SupplierID
	=
	@SuppID
	And
	
	Hide

	PACKSLIP.MAIN.SupplierID
	=
	@SuppID
	And
	
	Hide

	PO.MAIN.SupplierID
	=
	@SuppID
	And
	
	Hide

	PAYGROUP.MAIN.SupplierID
	=
	@SuppID
	
	
	Hide


Invoice by Inv Num and Supp ID

The table below provides the specific instructions necessary to create the Invoice by Inv Num and Supp ID Saved Search.  This search is used in the pre-defined Accounts Payable solution to retrieve just the Invoice document for a particular supplier and invoice number.

Application

	Selected Applications:
	INVOICE.MAIN


Result Fields

	Selected Fields:
	Column Header:

	INVOICE.MAIN.SupplierID
	SupplierID

	INVOICE.MAIN.InvoiceNumber
	InvoiceNumber

	INVOICE.MAIN.InvoiceDate
	InvoiceDate

	INVOICE.MAIN.InvoiceAmount
	InvoiceAmount

	INVOICE.MAIN.PONumber
	PONumber

	INVOICE.MAIN.DocType
	DocType

	INVOICE.MAIN.DocID
	DocID


Search Criteria

	Field List
	Compare
	Value
	And/Or
	Search Form

	INVOICE.MAIN.SupplierID
	=
	
	And 
	Prompted

	INVOICE.MAIN.InvoiceNumber
	=
	
	
	Prompted



Invoice App by Supplier ID

The table below provides the specific instructions necessary to create the Invoice App by Supplier ID Saved Search.  This search is used to test the successful filing of the INVOICE application.

Application

	Selected Application:
	INVOICE.MAIN


Result Fields

	Selected Fields:
	Column Header:

	INVOICE.MAIN.SupplierID
	SupplierID

	INVOICE.MAIN.InvoiceNumber
	InvoiceNumber

	INVOICE.MAIN.InvoiceDate
	InvoiceDate

	INVOICE.MAIN.InvoiceAmount
	InvoiceAmount

	INVOICE.MAIN.PONumber
	PONumber

	INVOICE.MAIN.DocID
	DocID

	INVOICE.MAIN.DocType
	DocType


Search Criteria

	Field List
	Compare
	Value
	And/Or
	Search Form

	INVOICE.MAIN.SupplierID
	=
	
	
	Prompt


Contract App by Supplier ID

The table below provides the specific instructions necessary to create the Contract App by Supplier ID Saved Search.  This search is used to test the successful filing of the CONTRACT application.

Application

	Selected Application:
	CONTRACT.MAIN


Result Fields

	Selected Fields:
	Column Header:

	CONTRACT.MAIN.SupplierID
	SupplierID

	CONTRACT.MAIN.ContractDate
	ContractDate

	CONTRACT.MAIN.DocType
	DocType


Search Criteria

	Field List
	Compare
	Value
	And/Or
	Search Form

	CONTRACT.MAIN.SupplierID
	=
	
	
	Prompt


PackSlip App by Supplier ID

The table below provides the specific instructions necessary to create the PackSlip App by Supplier ID Saved Search.  This search is used to test the successful filing of the PACKSLIP application.

Application

	Selected Application:
	PACKSLIP.MAIN


Result Fields

	Selected Fields:
	Column Header:

	PACKSLIP.MAIN.SupplierID
	SupplierID

	PACKSLIP.MAIN.PONumber
	PONumber

	PACKSLIP.MAIN.PSDate
	PSDate

	PACKSLIP.MAIN.DocType
	DocType


Search Criteria

	Field List
	Compare
	Value
	And/Or
	Search Form

	PACKSLIP.MAIN.SupplierID
	=
	
	
	Prompt


PayGroup App by Supplier ID

The table below provides the specific instructions necessary to create the PayGroup App by Supplier ID Named Search.  This search is used to test the successful filing of the PAYGROUP application.

Application

	Selected Application:
	PAYGROUP.MAIN


Result Fields

	Selected Fields:
	Column Header:

	PAYGROUP.MAIN.SupplierID
	SupplierID

	PAYGROUP.MAIN.InvoiceNumber
	InvoiceNumber

	PAYGROUP.MAIN.DueDate
	DueDate

	PAYGROUP.MAIN.ReportDate
	ReportDate

	PAYGROUP.MAIN.DocType
	DocType



Search Criteria

	Field List
	Compare
	Value
	And/Or
	Search Form

	PAYGROUP.MAIN.SupplierID
	=
	
	
	Prompt


PO App by Supplier ID

The table below provides the specific instructions necessary to create the PO App by Supplier ID Saved Search.  This search is used to test the successful filing of the PO application.

Application

	Selected Application:
	PO.MAIN


Result Fields

	PRIVATE
Selected Fields:
	Column Header:

	PO.MAIN.SupplierID
	SupplierID

	PO.MAIN.PONumber
	PONumber

	PO.MAIN.POAmount
	POAmount

	PO.MAIN.PODate
	PODate

	PO.MAIN.DocType
	DocType


Search Criteria

	Field List
	Compare
	Value
	And/Or
	Search Form

	PO.MAIN.PONumber
	=
	
	
	Prompt


Report App by Report Name

The table below provides the specific instructions necessary to create the Report App by Report Name Saved Search.  This search is used to test the successful filing of the REPORT application.

Application

	Selected Application:
	REPORT.MAIN


Result Fields

	Selected Fields:
	Column Header:

	REPORT.MAIN.ReportName
	Report Name

	REPORT.MAIN.ReportDate
	Report Date

	REPORT.MAIN.ReportTitle
	Report Title


Search Criteria

	Field List
	Compare
	Value
	And/Or
	Search Form

	REPORT.MAIN.ReportName
	=
	
	
	Prompt


CheckStub App by Supplier ID

The table below provides the specific instructions necessary to create the CheckStub App by Supplier ID Saved Search.  This search is used to test the successful filing of the CHECKSTUB application.

Application

	Selected Application:
	CHECKSTUB.MAIN


Result Fields

	Selected Fields:
	Column Header:

	CHECKSTUB.MAIN.SupplierID
	SupplierID

	CHECKSTUB.MAIN.CheckDate
	CheckDate

	CHECKSTUB.MAIN.CheckNumber
	CheckNumber

	CHECKSTUB.MAIN.CheckAmount
	CheckAmount

	CHECKSTUB.MAIN.DocTyoe
	DocType


Search Criteria

	Field List
	Compare
	Value
	And/Or
	Search Form

	CheckStubMain.SupplierID
	=
	
	
	Prompted


Implementing Workflow Process Files

Refer to the IBPM documentation for how to create a Process and a Package Template.  The Package Template fields must exactly match the application fields created with Filer. To update a package the Package Viewer must be open.

1. On the Process Builder server open Process Builder.

2. Select File.

3. Select Open Process from the menu.

4. Locate the JDE Integration – AP.PFW on the EIS CD.  The Process provides two maps, Main and Subflow.

5. Click File | Save. Save the process under a different name (JDE Voucher Entry.PFW) to the local drive to break the existing connection to the Process database.

6. Close and reopen Process Builder. The process requires being compiled and applied to complete the setup of the new JDE Voucher Entry.pfw process.

7. On the Process Broker server open the IBPM General Service Configuration program (GenCfg.EXE) and select the Process Broker tab.  Make sure the JDE Voucher Entry.pfw process is the Primary Package in the Server Roles table.

8. Assign the appropriate rights for the JDE Voucher Entry process using the security tool on an IBPM Client.

9. Add the Package in process to Start Voucher Entry.

10. Lock the Package in the WorkList.

11. Open OneWorld and using the Update button verify Process operates correctly.

	Mapping Type:
	Mapping Name:
	From – OneWorld Fields
	To – IBPM Fields

	Package Update
	Update Voucher Payment
	AP Short
	All Docs by SupplierID

	
	
	SupplierNumber
	SUPPLIERID

	
	
	InvoiceNumber
	INVOICENUM

	
	
	InvoiceAmount
	INVOICEAMOUNT

	
	
	InvoiceDate
	INVOICEDATE

	
	
	PONumber
	PONUMBER


Package Template Definition

Package Template Name – Voucher Package

Package Field Definitions

	Caption
	Type
	Length
	Search
	Value List

	SupplierID*
	String
	80
	✔
	

	InvoiceNumber*
	String
	80
	✔
	

	InvoiceDate
	DateTime
	
	✔
	

	InvoiceAmount*
	Decimal
	
	✔
	

	PONumber*
	String
	80
	✔
	

	DocID*
	String
	80
	✔
	

	DocType*
	String
	80
	✔
	

	InvoiceAccepted
	Boolean
	
	✔
	True

	SupervisorApproved
	Boolean
	
	✔
	True

	Investigate
	Boolean
	
	✔
	True

	CreateNewSupplier
	Boolean
	
	✔
	True

	InvoiceDeclinedReason
	String
	80
	✔
	

	SupplierName
	String
	80
	✔
	

	SupplierStreetAddress
	String
	80
	✔
	

	SupplierCity
	String
	80
	✔
	

	SupplierState
	String
	80
	✔
	

	SupplierZip
	String
	80
	✔
	


* This field is also in the INVOICE application and therefore the names must match exactly.

Package Fields Display Order

	Field Type
	Field Name

	User
	SupplierID

	User
	InvoiceNumber

	User
	InvoiceAmount

	User
	PONumber

	User
	DocID

	System
	Creator

	System
	Priority

	System
	Date Created

	System
	Date In Queue 

	System
	Due Date


Use the first 10 fields as the package title.

Mapping from the IBPM Client

Mapping in IBPM completes the process of assigning the values in the OneWorld database to data in the IBPM Database.  There are five mappings to be entered and five screen name assignments.  Although it is not a requirement, Stellent has adopted a standard of using the Saved Search name as the Mapping Name.  As systems get more complex and a Saved Search is called from multiple screens, this standard may not work.

For more detailed information on the EIS Map Tool see the InstallLOB.doc Installation document.

Invoice by Inv Num and Supp ID Mapping

1. Open the EIS Map Tool from the IBPM Windows Client by selecting it from the View menu.  There are two tabs in the EIS Map Tool that are used, Map Groups and Maps.

2. Select the Maps tab.  The fields in the dialog are currently inactive or closed.

3. Click the New button at the bottom of the dialog.

4. Select the Service Type of JDE OneWorld Data.

5. Select the data structure for the AP Short Data from the Service Templates drop down menu.

6. Click the green arrow that point to the right to move to the next stage.

7. Select the Service Type of IBPM Client Search.

8. Select the Invoice App by Inv Num and Supp ID Saved Search from the Service Template drop down menu.

9. In the list of fields in the input pipe, highlight the InvoiceNumber field.

10. Press the green arrows that point up and down until the InvoiceNumber field in the input pipe is in the same row as the InvoiceNumber field in the service input.

11. Click the Map button.  Three arrows appear showing the association between the two InvoiceNumber fields.

12. Use the same procedure to map SupplierNumber to SupplierID.

13. Click the Save button.

14. Type Invoice by Inv Num and Supp ID for the Map Name and click OK.

All Docs by Supplier ID Mapping

1. Open the EIS Map Tool from the IBPM Windows Client by selecting it from the View menu.  There are two tabs in the Map Tool that are used, Map Groups and Maps.

2. Select the Maps tab.  The fields in the dialog are currently inactive or closed.

3. Click the New button at the bottom of the dialog.

4. Select the Service Type of JDE OneWorld Data.

5. Select the AP Short Data data structure from the Service Templates drop down menu.

6. Click the green arrow that point to the right to move to the next stage.

7. Select the Service Type of IBPM Client Search.

8. Select the All Docs by Supplier ID Saved Search from the Service Template drop down menu.

9. In the list of fields in the input pipe, highlight the SupplierNumber field.

10. Press the green arrows that point up and down until the SupplierNumber field in the input pipe is in the same row as the SupplierID field in the service input.

11. Click the Map button.  Three arrows appear showing the association between the two Supplier fields.

12. Click the Save button.

13. Type All Docs by Supplier ID for the Map Name and click OK.

Contract App by Supplier ID Mapping

1. Open the EIS Map Tool from the IBPM Windows Client by selecting it from the View menu.  There are two tabs in the Map Tool that are used, Map Groups and Maps.

2. Select the Maps tab.  The fields in the dialog are currently inactive or closed.

3. Click the New button at the bottom of the dialog.

4. Select the Service Type of JDE OneWorld Data.

5. Select the data structure for the AP Short Data from the Service Templates drop down menu.

6. Click the green arrow that point to the right to move to the next stage.

7. Select the Service Type of IBPM Client Search.

8. Select the Contract App by Supplier ID Saved Search from the Service Template drop down menu.

9. In the list of fields in the input pipe, highlight the SupplierNumber field.

10. Press the green arrows that point up and down until the SupplierNumber field in the input pipe is in the same row as the SupplierID field in the service input.

11. Click the Map button.  Three arrows appear showing the association between the two Supplier fields.

12. Click the Save button.

13. Type Contract App by Supplier ID for the Map Name and click OK.

CheckStub App by Supplier ID Mapping

1. Open the EIS Map Tool from the IBPM Windows Client by selecting it from the View menu.  There are two tabs in the Map Tool that are used, Map Groups and Maps.

2. Select the Maps tab.  The fields in the dialog are currently inactive or closed.

3. Click the New button at the bottom of the dialog.

4. Select the Service Type of JDE OneWorld Data.

5. Select the data structure for the AP Short Data from the Service Templates drop down menu.

6. Click the green arrow that point to the right to move to the next stage.

7. Select the Service Type of IBPM Client Search.

8. Select the CheckStub App by Supplier ID Saved Search from the Service Template drop down menu.

9. In the list of fields in the input pipe, highlight the SupplierNumber field.

10. Press the green arrows that point up and down until the SupplierNumber field in the input pipe is in the same row as the SupplierID field in the service input.

11. Click the Map button.  Three arrows appear showing the association between the two Supplier fields.

12. Click the Save button.

13. Type CheckStub App by Supplier ID for the Map Name and click OK.

Update Invoice Package Mapping

1. Open the EIS Map Tool from the IBPM Windows Client by selecting it from the View menu.  There are two tabs in the Map Tool that are used, Map Groups and Maps.

2. Select the Maps tab.  The fields in the dialog are currently inactive or closed.

3. Click the New button at the bottom of the dialog.

4. Select the Service Type of JDE OneWorld Data.

5. Select the data structure for the AP Short Data from the Service Templates drop down menu.

6. Click the green arrow that point to the right to move to the next stage.

7. Select the Service Type of IBPM Client Process Update.

8. Select the VoucherPackage Package Template from the Service Template drop down menu.

9. In the list of fields in the input pipe, highlight the SupplierNumber field.

10. Press the green arrows that point up and down until the SupplierNumber field in the input pipe is in the same row as the SupplierID field in the service input.

11. Click the Map button.  Three arrows appear showing the association between the two Supplier fields.

12. Repeat this process to map the following fields.

	Input Pipe
	Service Input

	PurchaseOrder
	PONumber

	InvoiceNumber
	InvoiceNumber

	InvoiceDate
	InvoiceDate

	InvoiceDocType
	DocType

	Company
	SupplierName


13. Click the Save button.

14. Type Update Invoice Package for the Map Name and click OK.

Map Group Assignments

1. Open the IBPM Mapper Tool from the IBPM Windows Client if it is not already open.  There are two tabs in the Mapper Tool, Mapper and Map Groups.

2. Select the Map Groups tab.

3. If all of your maps do not appear in the Maps list box then press the “Refresh” button.

4. Click the “New” button.

5. Type W0411G in the Map Group Name dialog and press OK.

6. Double Click the All Docs by Supplier ID item in the Maps list box.

7. Double Click the Contract App by Supplier ID item in the Maps list box.

8. Double Click the CheckStub App by Supplier ID item in the Maps list box.

9. Double Click the Update Invoice Package item in the Maps list box.

10. Click the “Save” button.

11. Close the Map Tool.

Troubleshooting

While signing on for the first time on a Windows 95/98 machine, you get “jdecgrt: Unable to retrieve Business View information – Application P9881”.  A missing INI settings or a missing entry in the path may cause this.  See the section called Notes for Windows 95 / 98 Installs under Installing OneWorld Demo Jr.
On some machines, when the Autorun on the OneWorld CD is started, the screen is streaked and unreadable and the machine locks up.  Leave the CD in the drive and reboot the machine.  When the machine comes back up, the Autorun does not start.  Using Windows Explorer, run the SETUP.EXE from the root of the OneWorld CD.

Appendix A – OneWorld Development Machine Requirements

This information has been copied from the J.D. Edwards Knowledge Garden on June 20, 2001.  More current information may exist.  Visit the Stellent Technical Support for the latest list of minimal requirements.

OneWorld Xe Minimum Technical Requirements for Windows 2000 Desktop Platforms

The following tables list minimum hardware and software technical requirements for OneWorld desktop platforms or workstations. For additional information, please refer to the “Hardware and Software Requirements” section of your OneWorld Installation, Upgrade, or Update Guide.

Hardware Requirements

This table lists the minimum hardware requirements for all OneWorld desktop platforms.

	Hardware
	Requirements
	Notes

	CPU
	Intel Pentium 300 
	Pentium 500 (recommended)

	RAM
	128 MB (minimum)
	256 MB (recommended)

	Hard Drive
	450 MB – 2.1 GB free
	450 MB – Partial without development objects.

1.34 GB – Full without development objects.

1.65 GB – Full with development objects.

2.1 GB – Standalone with development objects.

	Display Colors
	256 colors - 8 color panes (minimum)
	65536 colors -16 color panes (recommended)

	Screen Resolution
	800 X 600 pixels (minimum)
	

	Printer Support
	Post Script 2, PCL 5 or line
	


OneWorld B73.3.2 Minimum Technical Requirements for Windows 2000 Desktop Platforms

The following tables list minimum hardware and software technical requirements for OneWorld desktop platforms or workstations. For additional information, please refer to the “Hardware and Software Requirements” section of your OneWorld Installation, Upgrade, or Update Guide.

Hardware Requirements

This table lists the minimum hardware requirements for all OneWorld desktop platforms.

	Hardware
	Requirements
	Notes

	CPU
	Intel Pentium 300 
	Pentium 500 (recommended)

	RAM
	128 MB (minimum)
	256 MB (recommended)

	Hard Drive
	450 MB – 2.1 GB free
	450 MB – Partial without development objects.

1.34 GB – Full without development objects.

1.65 GB – Full with development objects.

2.1 GB – Standalone with development objects.

	Display Colors
	256 colors - 8 color panes (minimum)
	65536 colors -16 color panes (recommended)

	Screen Resolution
	800 X 600 pixels (minimum)
	

	Printer Support
	Post Script 2, PCL 5 or line
	


OneWorld B73.3.1 Minimum Technical Requirements for Windows 2000 Desktop Platforms

The following tables list minimum hardware and software technical requirements for OneWorld desktop platforms or workstations. For additional information, please refer to the “Hardware and Software Requirements” section of your OneWorld Installation, Upgrade, or Update Guide.

Hardware Requirements

This table lists the minimum hardware requirements for all OneWorld desktop platforms.

	Hardware
	Requirements
	Notes

	CPU
	Intel Pentium 300 
	Pentium 500 (recommended)

	RAM
	128 MB (minimum)
	256 MB (recommended)

	Hard Drive
	320 MB – 1.8 GB free
	320 MB – Partial without development objects.

992 MB – Full without development objects.

1.49 GB – Full with development objects.

1.8 GB – Standalone with development objects.

	Display Colors
	256 colors - 8 color panes (minimum)
	65536 colors -16 color panes (recommended)

	Screen Resolution
	800 X 600 pixels (minimum)
	

	Printer Support
	Post Script 2, PCL 5 or line
	


OneWorld Xe Minimum Technical Requirements for Windows 95, 98, and NT Platforms

The following tables list minimum hardware and software technical requirements for OneWorld desktop platforms or workstations. For additional information, please refer to the “Hardware and Software Requirements” section of your OneWorld Installation, Upgrade, or Update Guide.

Hardware Requirements

This table lists the minimum hardware requirements for all OneWorld desktop platforms.

	Hardware
	Requirements
	Notes

	CPU
	Intel Pentium 233 
	Pentium 500 (recommended)

	RAM
	128 MB (minimum)
	256 MB (recommended)

	Hard Drive
	450 MB – 2.1 GB free
	450 MB – Partial without development objects.

1.34 GB – Full without development objects.

1.65 GB – Full with development objects.

2.1 GB – Standalone with development objects.

	Display Colors
	256 colors - 8 color panes (minimum)
	65536 colors -16 color panes (recommended)

	Screen Resolution
	800 X 600 pixels (minimum)
	

	Printer Support
	Post Script 2, PCL 5 or line
	


Software Requirements

This table lists the minimum software requirements for all OneWorld desktop platforms.

	Software
	Requirements
	Notes

	Operating System
	Microsoft Windows 98 (supported through SP17), or

Windows NT 4.0 Workstation w/ SP5 or higher
	For Windows NT SP6a is strongly recommended.

Do not use OEM versions of Microsoft Windows 95 or 98.

Development on Windows 98 and Windows 95 is not recommended.


OneWorld B73.3.2 Minimum Technical Requirements for Windows 95, 98, and NT Platforms

The following tables list minimum hardware and software technical requirements for OneWorld desktop platforms or workstations. For additional information, please refer to the “Hardware and Software Requirements” section of your OneWorld Installation, Upgrade, or Update Guide.

Hardware Requirements

This table lists the minimum hardware requirements for all OneWorld desktop platforms.

	Hardware
	Requirements
	Notes

	CPU
	Intel Pentium 120 
	Pentium 166 (recommended)

	RAM
	64 MB (minimum)
	96 MB (recommended)

	Hard Drive
	450 MB – 2.1 GB free
	450 MB – Partial without development objects.

1.34 GB – Full without development objects.

1.65 GB – Full with development objects.

2.1 GB – Standalone with development objects.

	Display Colors
	256 colors - 8 color panes (minimum)
	65536 colors -16 color panes (recommended)

	Screen Resolution
	800 X 600 pixels (minimum)
	

	Printer Support
	Post Script 2, PCL 5 or line
	


OneWorld B73.3.1 Minimum Technical Requirements for Windows 95, 98, and NT Platforms

The following tables list minimum hardware and software technical requirements for OneWorld desktop platforms or workstations. For additional information, please refer to the “Hardware and Software Requirements” section of your OneWorld Installation, Upgrade, or Update Guide.

Note: Windows 95 or Windows 98 to a Windows 2000 server is not supported.

Hardware Requirements

This table lists the minimum hardware requirements for all OneWorld desktop platforms.
	Hardware
	Requirements
	Notes

	CPU
	Intel Pentium 120 
	Pentium 166 (recommended)

	RAM
	64 MB (minimum)
	96 MB (recommended)

	Hard Drive
	320 MB – 1.8 GB free
	320 MB – Partial without development objects.

992 MB – Full without development objects.

1.49 GB – Full with development objects.

1.8 GB – Standalone with development objects.

	Display Colors
	256 colors - 8 color panes (minimum)
	65536 colors -16 color panes (recommended)

	Screen Resolution
	800 X 600 pixels (minimum)
	

	Printer Support
	Post Script 2, PCL 5 or line
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		Field Name		Field Type		Separator		Decimal Point		Currency		Negative		Precision		Date Separator		Start Line		End Line		Start Column		End Column		Physical Field Length		Remember Field		Pattern		Beginning Occurrence		Pattern		Ending Occurrence		Validation Mask		Do Not File		Allow Blanks		Extern Name		Default Value		Negate Mask

		SupplierID		Exact														1		1		26		100		8				| (Pipe)		1		| (Pipe)		1		All fields and check boxes blank

		CheckDate		Date(MDY)												-		1		1		26		100						| (Pipe)		2		| (Pipe)		1		All fields and check boxes blank

		CheckNumber		Exact														1		1		26		100						| (Pipe)		3		| (Pipe)		1		All fields and check boxes blank

		CheckAmount		Floating Point										2				1		1		26		100						| (Pipe)		4		| (Pipe)		1		All fields and check boxes blank

		DocType		Exact														1		1		26		100		25				| (Pipe)		5		| (Pipe)		1		All fields and check boxes blank
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		Payment Edit Group Report Application

		Type																Scope																				Validation

		Field Name		Field Type		Separator		Decimal Point		Currency		Negative		Precision		Date Separator		Start Line		End Line		Start Column		End Column		Physical Field Length		Remember Field		Pattern		Beginning Occurrence		Pattern		Ending Occurrence		Validation Mask		Do Not File		Allow Blanks		Extern Name		Default Value		Negate Mask

		DueDate		Date(MDY)												/		11		19		89		98														All fields and check boxes blank

		InvoiceNumber		Exact														11		19		99		125		25												All fields and check boxes blank

		ReportDate		Date(MDY)												/		2		2		189		197				X										All fields and check boxes blank

		SupplierID		Exact														11		20		164		171		8												All fields and check boxes blank

		DocType		Exact														2		2		74		99		25		X										All fields and check boxes blank





Sheet2

		





Sheet3

		






_1041665223.xls
Sheet1

		Packing Slip Application

		Type																Scope																				Validation

		Field Name		Field Type		Separator		Decimal Point		Currency		Negative		Precision		Date Separator		Start Line		End Line		Start Column		End Column		Physical Field Length		Remember Field		Pattern		Beginning Occurrence		Pattern		Ending Occurrence		Validation Mask		Do Not File		Allow Blanks		Extern Name		Default Value		Negate Mask

		SupplierID		Exact														1		1		26		100		8				| (Pipe)		1		| (Pipe)		1		All fields and check boxes blank

		PSDate		Date(MDY)												-		1		1		26		100						| (Pipe)		2		| (Pipe)		1		All fields and check boxes blank

		PONumber		Exact														1		1		26		100		8				| (Pipe)		3		| (Pipe)		1		All fields and check boxes blank

		DocType		Exact														1		1		26		100		25				| (Pipe)		4		| (Pipe)		1		All fields and check boxes blank
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		Contract Application

		Type																Scope																				Validation

		Field Name		Field Type		Separator		Decimal Point		Currency		Negative		Precision		Date Separator		Start Line		End Line		Start Column		End Column		Physical Field Length		Remember Field		Pattern		Beginning Occurrence		Pattern		Ending Occurrence		Validation Mask		Do Not File		Allow Blanks		Extern Name		Default Value		Negate Mask

		SupplierID		Exact														1		1		26		100		8				| (Pipe)		1		| (Pipe)		1		All fields and check boxes blank

		ContractDate		Date (MDY)												-		1		1		26		100						| (Pipe)		2		| (Pipe)		1		All fields and check boxes blank

		DocType		Exact														1		1		26		100		25				| (Pipe)		3		| (Pipe)		1		All fields and check boxes blank
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